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0 HISTORIC REVIEW

V1.3 AUGUST 2004

- New Desktop Panel TP7210.

- New Menu for TP7100 LCD.

- Level variation at analogue interfaces TA7000.
- Electric schematics incorporated.

- Manuals unified (technical, user, software).

V1.2 OCTOBER 2003

- INDICO GUI Upgrade
- New equipments:

e TM7016, TM7024 matrixes (16x16 and 24x24 XPT respectively).

e TW7000 Wireless Intercom System.
e TA7004 Telephone Set Interface.
- New Functioning:
e Online Menu.
e XPT by DTMF telephone set.

V1.1 AUGUST 2003

- Individually installed equipments:
e Rear panel views.

e pinout for the new double rear panel for interfaces.

- New functioning:
e Tally’s at terminales.
e XPT by DTMF telephone set.
- INDICO GUI Upgrade.
- New equipments:
e TA7001 interface for ISDN Audiocodec (Pronto2).
e TA7002 PSTN line interface.
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1 MAIN FEATURES TB7000

1.1 MASTER TM7000

Controller can manage up to 128x128 (which consists of four 32x32 matrixes).
Up to 8 config maps can be stored, called.

Map loading from floppy disk (via front panel or PC).

User interface thru LCD and front keyboard: status checking, ports assigned
and maps available.

Map config thru windows-run “Indico” software.

PC Connection thru RS232, which allows online edit & load of maps, XPT
checking.

Redundant PS available with voltage leds.

Connection thru twisted 8-wire FTP CAT 5 with RJ45 connectors.

1.2 MATRIX TM7032

32-port modules (32x32 crosspoints), escalable to 128x128 (four 32-port
modules). For more-than-128x128 maps, a RL7124 router is needed
(1024x1024 max).

Distributed topology: phisically separated units are networked thru local ring.
XPT level variation from —12dB till +12dB.

16-bit digital resolution.

Connection thru twisted 8-wire FTP CAT 5 with RJ45 connectors.

1.3 PANELS TP7000

Transmission/Reception of audio/data in digital format, full duplex, with
independednt lines in each way of the cable.

Diverse functioning of keys (LATCH or PTT or both) configurable via software at
user level.

24-bit codec with 41,66Khz interpolation.

Level control of digital port and analogue aux port thru a potentiometer at front
panel.

XPT level variation from —12dB till +12dB.

Analogue Aux Input/Output. As an option, this port can be connected to an
analogue matrix (KROMA TB6000 type).

Dettachable mic with XLR connector: choose among dynamic or electrect by
jumper hardware.

Headset connection thru front panel with jack connector.

GPIO Input/Output with aux tally.

External Power Supply (+15v).

Connection thru twisted 8-wire FTP CAT 5 with RJ45 connectors.

Different type of panels:
e TP7016 -> 16-key panel. 1 Unit high.
e TP7010 -> 16-key panel with double LCD and reconfigurable labels. 2
Units high.
e TP7100 -> 8-key panel with graphic LCD that allows the systems
configuration. 2 Units high.
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e TP7210 -> Desktop 16-key panel with LCD and dialling keypad for
managing calls.

1.4 INTERFACES

They can either fit into the frame rack TR7000 or being rack-mounted.

1.4.1 INTERFACES FOR RACK FRAME TR7000

Interface Boards for connecting external audio sources, analogue signals or
interconnections with other equipments, to be fitted into the rack frame TR7000.
Each rack frame can have up to 12 boards (6 pairs).

24-bit resolution codecs.

Input/Output analogue margin: 12dBuv.

Level variation of digital ports from -12dB and +12dB.

Different types of interfaces:

e TA7000 -> Interface for 4-wire analogue sources. With 4 ports.
Transformer-isolated.

e TA7003 -> Interface for 2-wire analogue sources. With 4 ports.
Transformer-isolated.

e TA7002 -> Interface for PSTN telephone lines. With two ports. It
implements FXO interface (tip, ring).

e TA7004 -> Interface for Phonesets. With two ports. | t implemets FXS
interface.

e TD7000 -> Interface for ISDN (G.711 protocol). With two ports.
Configurable for two B channels of one line or one B channel of two
lines.

e TA7001 -> Interface for ISDN (G.722 protocol). With two ports. For
remotely controlling Pronto2 audiocodec from an user panel.

e TD7001 -> Interface for GSM (900Mhz y 1800Mhz). With one port.

Each digital port has independent inputs, so they can be grouped via software.
Connection thru twisted 8-wire FTP CAT 5 with RJ45 connectors.

Analogue connection thru SUBD9 and SUBD62 (high density).

Redundant Power Supply with led indicators.

1.4.2 AUTONOMOUS UNITS

Autonomous Units for the interconnection of external networks to the intercom
system, GPIOs, repeaters, etc.

Integration with config software (INDICO).

24-bit resolution codecs.

Input/Output analogue margin: 12dBuv.

Individual level variation between -12dB and +12dB.

Interfaces:

e TI7011 -> Interface for connecting Voice-Over-IP to the digital matrix.
Useful for remote panels without matrixes and connection with systems
via virtual IP port (100Kb/s minimum bit rate).

e GP7020 -> With 20 configurable GPIOs. Optoisolated inputs are
activated by tension, inputs are activated by contact closure.

Connection thru twisted 8-wire FTP CAT 5 with RJ45 connectors.
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1.5 MECHANICAL SPECIFICATIONS

TM7000 - 1 Unit high, full rack, 41 cm deep, 6,5 Kg weight.
TM7032 - 1 Unit high, full rack, 47 cm deep, 4 Kg weight.
TM7064 - 2 Units high, full rack, 41 cm deep, 8 Kg weight.
TM7096 - 3 Units high, full rack, 47 cm deep, 12 Kg weight.
TM7128 - 4 Units high, full rack, 47 cm deep, 16 Kg weight.
TP7010 - 2 Units high, full rack, 15 cm deep, 3,4 Kg weight.
TP7016 - 1 Unit high, full rack, 15 cm deep, 2,5 Kg weight.
TP7100 - 2 Units high, full rack, 15 cm deep, 3,4 Kg weight.
TP7210 - 8,5 cm high, 26,5 cm wide, 18 cm deep. 2,1 Kg weight.
TR7000 - 3 Units high, full rack, 35 cm deep, 4 Kg weight (w/o boards).
TI7011 = 1 Unit high, full rack, 32 cm deep, 4,7 Kg weight.
GP7020 - 1 Unit high, full rack, 18 cm deep, 2,2 Kg weight.
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2 SET UP

2.1 MASTER TM7000

When rack-mounting the controller, leaving one free unit high above it is
recommended for ventilation purposes.

One external power supply is provided with the equipment. Redundant PS is
advisable though. Its connectors are located at the right side of the rear panel, labeled
as A and B. A front led would indicated when a missing or faulty PS.
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Figure 2.1 Rear View of TM7000.

RS232 communication (PC) is done via propietary protocol. For the cabling,
follow this pinout:

SUBD9 MALE PC SUBD9 MALE MASTER

1 No connect 1 No connect

2 Transmitter 2 Transmitter

3 Receiver 3 Receiver

4 No connect 4 No connect

5 Gnd 5 Gnd

6 No connect 6 No connect

7 No connect 7 No connect

8 No connect 8 No connect

9 No connect 9 No connect

Scheme 2.1 PC-TM7000 pinout.

Pins 2 and 3 must be twisted and pin5 with ground. Female SUBD9
connectors are used between COM port and male SUBD9 connector of the TM7000.

Connection with Matrix is done by the first four RJ45 connectors, labeled as
“Digital XPT’s”. For the pinout, see page 11.

Other TM7000 connectors are only used by technical staff of Kroma.
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2.2 MATRIX TM7032-64-96-128

The closer the matrix to the Master, the better (max distance allowed: 10m).
One next to the other is advised. See figure below.

1FREE RACK

MASTER

1t 5358 ==

MATRI 32K32

0 affo ofo ojo 0
0 ofo ofo ofjo 0

MATRE 32832

Figure 2.2 64x64 matrix location

Matrix is powered with the same type of PS of the Master, thru rear connectors
labeled as ‘Power A’ and ‘Power B’ located at the left side of the rear panel. One
external power supply is provided with the equipment. Redundant PS is advisable
though.

o Dwver R =W .- = )
F.P | ] ]}
A L P |
) e MOUT 3 29 o dighal ports T 1|

Figure 2.3 Rear View of the Matrix

32 matrix ports are available (labeled as 0 to 31) where TP7000 user panels,
TR7000 interface boards and TW7000 wireless intercom can be connected. First port
is located at the right upper side. The rest to 31 goes up to the left.

Master-Matrix interconnection is done between “M-out” (Matrix) and “XPT
digital” (Master) RJ45 connectors. Synchro data for the whole system go thru this data
line. For that reason, connection must be strongly fixed.

See below a 32x32 matrix connection to the master.
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Figure 2.4 32x32 matrix connection to master.

MASTER

MATRL

For keeping the dynamic nature of each matrix, follow these instructions when
connection master and different matrixes:

MATRIX

MASTER

1 Matrix TM7032 32x32

Matrix 0: MOUT

TO DIGITAL XPT 0

2 Matrix TM7064 64x64

Matrix 0: MOUT

TO DIGITAL XPT 0

Matrix 1: MOUT

TO DIGITAL XPT 1

3 Matrix TM7096 96x96

Matrix 0: MOUT

TO DIGITAL XPT 0

Matrix 1: MOUT

TO DIGITAL XPT 1

Matrix 2: MOUT

TO DIGITAL XPT 2

4 Matrix TM7128 128x128

Matrix 0: MOUT

TO DIGITAL XPT 0

Matrix 1: MOUT

TO DIGITAL XPT 1

Matrix 2: MOUT

TO DIGITAL XPT 2

Matrix 3: MOUT

TO DIGITAL XPT 3

Scheme 2.2 Matriz-Master connection

Kroma provides the master-matrix connection. Connection thru twisted 8-wire
FTP CAT 5 with RJ45 connectors. See the pinout figure below:
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Figure 2.5 Pinout of Matriz-Master.

When more than 32x32 maps, ring interconnection among matrixes is needed, so
they can share the audio multiplexes.

A 64x64 configuration consists of two 32x32 matrixes, each one connected to
the Master and also between them thru RJ45 connectors labeled as ‘MXAI' and
‘MXAO’ (Multiplex A Input, Multiplex A Output). See page 14 for the pinout and below
for the interconnection.

®PTO
Lo 1 Lo
B | ey MASTER
- O = i I'ch::: '@' '@' D
WP
o
Lo Loy
=]
=== MATRIX 0
°° HCLE. -
ol 20 MCUT
i 2l
Lo Loy
=]
==t MATRIX 1
|99 o TRl ;
ht{ A AT

Figure 2.6 64x64 Matrix-Master interconection.
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A 96x96 configuration consists of three 32x32 matrixes, each one connected to
the Master and also between them thru RJ45 connectors labeled as ‘MXAI' and
‘MXAO’ (Mdltiplex A Input, Multiplex A Output). See below for the interconnection..

¥PTO
Loy 1
#*PT2| || [ %PT
A :
= =
=]
- @ @ |-"| :-I__ _
Rt 2.0 pMoUT | ||
M A N
= =
=]
|99 R 2
WA AD MoUT | ||
M A
Lo
=]
|®® aTA
MM A MOIT

Figure 2.7 96x96 matrix-master interconnection.

MASTER

MATREX O

PATRE 1

MATRE 2

A 128x128 configuration consists of four 32x32 matrixes, each one connected
to the Master and also between them thru RJ45 connectors labeled as ‘MXAI" and
‘MXAO’ (Mdltiplex A Input, Multiplex A Output). See below for the interconnection..
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Figure 2.8 128x128 matrix-master interconnection.

MASTER

MATREX O

P ATRE 1

MATRE 2

MATRIEX 3

Connection thru twisted 8-wire FTP CAT 5 with RJ45 connectors. It's a pin to
pin configuration. See the chart below:

MATRIX MATRIX
1 Matrix 32x32
No connect No connect
2 Matrix 64x64
Matrix 0: MXAO Matrix 1: MXAI
Matrix 1: MXAO Matrix 0: MXAI
3 Matrix 96x96
Matrix 0: MXAO Matrix 1: MXAI
Matrix 1: MXAO Matrix 2: MXAI
Matrix 2: MXAO Matrix 0: MXAI
4 Matrix 128x128
Matrix 0: MXAO Matrix 1: MXAI
Matrix 1: MXAO Matrix 2: MXAI
Matrix 2: MXAO Matrix 3: MXAI
Matrix 3: MXAO Matrix 0: MXAI

Chart 2.3 Audio interconnection among matrixes.
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2.3 PANELS TP7000

All user panels are connected in the same way, even TP7210, the desktop
terminal.

Rack-mounted panels (TP7100, TP7010 and TP7016) are powered by external
PS (+15v) thru jack connector at the left side of the rear panel. This PS is supplied with
the equipment and is compatible with TW7000 wireless intercom.

There are cable fixers next to the jack entry to avoid disconnections. See below
the rear panel of panels TP7016, TP7010 and TP7100.

< -
dp?n_rrttal port analog
povver ble fi tallys , Ext W0 faux analog
caple Txer
> © © -

Figure 2.10 Rear view of rack-mount panels.

PS of desktop panel (+12v, -12v and +5v) is not compatible with rack-mount
panels and does not need cable fixers as it uses twisted connectors. See below its rear
view:

o ok e e ® 0 Ll'e)

Figure 2.11 Rear view of TP7210.

Connection with matrix is made with a twisted 8-wire FTP CAT 5 cable with
RJ45 connectors (digital port). Max distance: 300m. See below the pinout (pin-to-pin):
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omEES oSS
12345678 12345673
. = =" . = ="
s e o s e
1 1 | |
1 1 RJ45 Fd45 | |
| | | |
L1 L1
MATRIX TERMINAL PANEL
DATA-AUDIO

L

Figure 2.12 Matrix-panel pinout.

Panels are provided with an analogue auxiliary input/output for them to be
connected to the analogue matrix (TM6000), so they may serve as analogue panels as
well. Panels may work as digital, analogue or both at the same time.

In the last case, there will be keys programmed from digital software and other
keys from the analogue config programme. Do not assign both systems to the same
key as the difference in response time may generate malfunctioning.

Digital level is varied with the potentiometer labeled as “Main” at the front panel.
Analogue audio will be changed with the “Aux” control.

This aux port can also be used for 4-wire external audio sources (on-air local
monitoring, floor manager communications) and be sent (together with the audio
coming from the panel’s microphone) to the digital matriz. The audio coming from the
digital matrix or the microphone may also be output thru the aux port (if chosen by
jumper). See below the analogue audio configuration thru the SUBD9 conector:
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Figure 2.13 Input/Output Audio Configuration.

If we want to send the digital audio coming from the matrix to the aux analogue
connector, we should change the jumper at solder J6. If not changed, the audio coming

from the mic will be sent then. See below:
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Figure 2.14 Configuration of analogue audio from digital matrix.
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For the aux analogue I/O, see below the pinout of the male SUBD9 connector.

SUBD9 MALE

FUNCTION TP7000

DATA -

DATA +

GND

OUT analog audio -

OUT analog audio +

GND

IN analog audio -

IN analog audio +

OO |NO|O|~|WIN|—

GND

Chart 2.4 Analogue port pinout.

On the rear panel, the user may also find GPIO for tally purposes. It can be
easily programmed (as it's done with keys) for general purpose functions such as on
air, video switchers, etc. Input is activated by tension (+12v), output is activated by
contact closure. See below the pinout. [NB: Desktop panel (TP7210) does not come

with this 1/O].
INPLIT OUTPUT
- 5 & o
1 2 1 2
TALLY'S

INPLT: OUTPUT:

1IN+ 1 OUT OnMOFF
21 - 2 0UT OM/OFF

Figure 2.15 Tally I/O Pinout.
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2.4 INTERFACES

2.4.1 RACK FRAME TR7000

Interfaces are inserted in a rack-mounted frame (3 units high) with up to 12
slots. Max distance with matrix: 300m. [NB: When digitizing analogue signals, the
shorter the distance between the analogue source and the A/D converter board, the
better, so as to have a S/N ratio high enough])

It is provided with redundant power supply (220v, with option to switch to 110v —
check electrical schematics). They're front-swappable — before unplugging them,
uncrew the security bolts above mains connectors on the rear panel. See below:

& Secur%@ o [ | | a—— T—
SCrewy
o % & .
= | | =| || carps carDs ||| carps cerps ||| carps ||| carps
B A8 AB AB A A
a & ||crRours ||| eRours ||| croup ||| erours ||| eroue2 ||| croue
< POINER <
SUPPLY
P ]| ]| &)@ s o] o]

Figure 2.16 Rear view of TR7000.

Boards are inserted at the front panel, connecting to its rear panel (where the
connectors for external sources are located). Rear panels can be:

Double - They connect two boards of the same type together. Up to six
double rear panels can be fitted into the rack frame, totalling 12 boards.

Single > The connect to one board. Up to six single rearpanels can be fitted
into the rack frame, totalling six boards. The other six slots are blank
panelled.

o
o

o

]

s

o

[
o

&

=
=
=
o
o
o
=
=)
=)
=
=)
oo @

CARD 1A
CARD 1B
CARD 1A
CARD 1B
CARD 1A
CARD 1B
CARD 1A
CARD 1B
CARD 1A
CARD 1B

CARD 1B
@ ¥ leds power =)
oo

& @ leds povwer

ailel[eflle*]la)|lele|]l®]|2@])|]®]®

GROUPY  GROUPZ  GRCOUP3 GROUP4 GROURPS GROUPE

Figure 2.17 Front view - TR7000 with double rear panels (12 boards)
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With double rear panels, the user can have up to 12 boards. NB: there must be
six pairs of boards, not 12 different boards. NB: its high density connectors may make
the installing somewhat difficult.

R IEREN IERENEREN EREN EREE ® @
] ]
< O o |
= = e e = = T T
- - - - - - z S
[ ] ] ] ] ] [u] o
[V [Tl [T [ [T [Tl -3 =
= = =) = = =) P i
L) [} L} L) [} L} E E
O B A <
@ | & & | & | [ a | & o | & @ | @ & o

GROUPY  GROUPZ  GROUP3 GROUPY4 GROUPS GROUPE

Figure 2.18 front View - TR7000 with single rear panels (6 boards)

User must specify what type of rear panel she prefers.

Each board must match its rear panel. NB: Do not mismatch them.
Permanent malfunctioning may occur.

Connection is done thru twisted 8-wire FTP CAT 5 with RJ45 connectors.
Analogue connection will depend on the type of rear panel selected.

PS is redundant and provides —20v and +20v. Leds will indicate missing or
faulty PS.

2.4.2 ANALOGUE TA7000, TA7003

Interfaces for analogue sources (4-wire TA7000 and 2-wire TA7003) are
provided with four ports. Each one must be connected to the matrix by a different cable
and thru the RJ45 connectors.

There are two types of rear panels (each one fills two slots):

- Single > for one board. With four RJ45 connectors and four female SUBD9
connectors.

- Double - for two boards (two TA7000, two TA7003 or one TA7000 and
one TA7003). With 8 RJ45 connectors and one female SUBD62 connector.

At the single rear panel, each analogue/digital port consists of a pair of SUBD9-
RJ45 connectors, beginning with “zero” (upper part) and ending with three” (lowest part
of the board):

Page 20 Digital Intercom



TB7000

DI. ..!..-... D
|
port 0
DI. -...--... D
|
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{:}I. .-!-.-.-. '\':"
il
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Dl .-!-.-... D
= o
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Figure 2.19 Single rear panel of TA7000 and TA7003.

The analogue connectors may be used for connecting to the Analogue Intercom

TB6000 or as Input/Output with the following pinout:

SUBD9H FUNCTION TA7000 FUNCTION TA7003
1 DATA - DATA -
2 DATA + DATA +
3 GND GND
4 IN analog audio - IN/OUT analog audio -
5 IN analog audio + IN/OUT analog audio +
6 Power source +20v Power source +20v
7 OUT analog audio - Reserved
8 OUT analog audio + Reserved
9 Power source —20v Power source —20v

Tabla 2.5 Pinout for analogue connector.

1 and 2 pins are not necessary to be connected as they are reserved for

remotely controlling thru RS-485.

Double rear panel consists of 8 digital/analogue ports. See below:
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Figure 2.20 Rear view of double TA7000 and TA7003.

The whole analogue connection (Input/Output) is made at the female SUBD62.

For a TA7000 and numbering the ports from 0 to 7, this is the pinout:

PIN FUNCTION PIN FUNCTION PIN FUNCTION
TA7000 TA7000 TA7000

1 Data-0 22 Data — 4 43 In Audio + 4

2 Data + 0 23 Data + 4 44 In Audio — 4

3 In Audio + 0 24 | Out Audio—0 | 45 | Out Audio —4
4 In Audio — 0 25 | Out Audio+0 | 46 | Out Audio +4

5 In Audio + 1 26 GND 47 In Audio + 5

6 In Audio — 1 27 GND 48 In Audio — 5

7 Data — 1 28 | Out Audio—5 | 49 Data-5

8 Data + 1 29 | Out Audio+5 | 50 Data + 5

9 Out Audio — 1 30 | Out Audio + 1 51 In Audio + 6
10 In Audio + 2 31 GND 52 In Audio — 6
11 In Audio — 2 32 GND 53 Data—6
12 Data—2 33 | Out Audio—6 | 54 Data + 6
13 Data + 2 34 | Out Audio +6 | 55 In Audio + 7
14 | Out Audio—2 | 35 | OutAudio+2 | 56 In Audio — 7
15 In Audio + 3 36 GND 57 Data — 7
16 In Audio — 3 37 GND 58 Data + 7
17 Data—3 38 | Out Audio—7 | 59 | Out Audio +7
18 Data + 3 39 GND 60 GND

19 | Out Audio—3 | 40 | Out Audio +3 | 61 + 20v Vout
20 + 20v Vout 41 + 20v Vout 62 - 20v Vout
21 - 20v Vout 42 - 20v Vout - -

Chart 2.6 Pinout for SUBD62 - TA7000.
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For a TA7003 and numbering the ports from 0 to 7, this is the pinout:

PIN FUNCTION PIN FUNCTION PIN FUNCTION
TA7003 TA7003 TA7003
1 Data -0 22 Data -4 43 In/Out Audio + 4
2 Data+ 0 23 Data + 4 44 In/Out Audio — 4
3 In/Out Audio + 0 24 Reserved 45 Reserved
4 In/Out Audio — 0 25 Reserved 46 Reserved
5 In/Out Audio + 1 26 GND 47 In/Out Audio + 5
6 In/Out Audio — 1 27 GND 48 In/Out Audio — 5
7 Data — 1 28 Reserved 49 Data—5
8 Data + 1 29 Reserved 50 Data + 5
9 Reserved 30 Reserved 51 In/Out Audio + 6
10 In/Out Audio + 2 31 GND 52 In/Out Audio — 6
11 In/Out Audio — 2 32 GND 53 Data—6
12 Data — 2 33 Reserved 54 Data + 6
13 Data + 2 34 Reserved 55 In/Out Audio + 7
14 Reserved 35 Reserved 56 In/Out Audio — 7
15 In/Out Audio + 3 36 GND 57 Data—7
16 In/Out Audio — 3 37 GND 58 Data + 7
17 Data — 3 38 Reserved 59 Reserved
18 Data + 3 39 GND 60 GND
19 Reserved 40 Reserved 61 + 20v Vout
20 + 20v Vout 41 + 20v Vout 62 - 20v Vout
21 - 20v Vout 42 - 20v Vout - -

Chart 2.7 Pinout for SUBD62 - TA7003.

Connection is done thru twisted 8-wire FTP CAT 5 with RJ45 connectors. Max
distance to matrix: 300m.

Inside TA7003 there are four potentiometers in case the user may want to
increase the Sidetone (return signal). By default, they are adjusted to a minimum of

10%:

o

O
“[

I:I
1

[ O da

O Oda

O &3

FORTO FORT1

PORTZ

PORTS

O
1
OV opoopoogoog o

ALDIC RETURM FIT

Figure 2.21 Adjustment of sidetone - TA7003.
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- PORT 0 - Sidetone adjustment at potentiometer R24.
- PORT 1 > Sidetone adjustment at potentiometer R62.
- PORT 2 - Sidetone adjustment at potentiometer R103.
- PORT 3 - Sidetone adjustment at potentiometer R141.

TA7000 is transformer-isolated, so if the analogue equipment to be connected
does not have transformer, common pin must be connected to ground.

See below examples of how to use TA7000 with single rear panel. In case of

double rear panel, all analogue audio sources go to one SUBD62. There should be
stated the digital ports to be used and then connect to the assigned analogue pins.
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Figure 2.22 TA7000 — examples of use.
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- BP6000 = analogue beltpack with a male 7-pin DIN connector. See below
the pinout with the matrix:

DIN 7 270 MALE FUNCTION BP6000
1 OUT analog audio +
GND
IN analog audio +
OUT analog audio -
IN analog audio -
Supply source -v
Supply source +v
Chart 2.8 BP6000 Pinout.

N[O~ Wi

Beltpack connects directly to an analogue port of the rear panel of TA7000. The
pinout is:

DIN 7 270 FEMALE TO BP6000 SUBD9 MALE TO TA7000
1

N[OOI~ Wi
D O|N[H~|O (WO

Chart 2.9 Pinout TA7000 and BP6000.
Cable to use is 7 x 0.11 with a max distance of 50m.

- CE6000 = Concentrator for analogue sources with six ports. A male 15-pin
SUBD connects to the matrix with the following pinout:

SUBD 15 MALE FUNCTION CE6000
OUT analog audio +
OUT analog audio -
GND
GND
Supply source +v
Supply source —v
Reserved
Reserved
GND
GND
IN analog audio +
IN analog audio -
GND
GND
Reserved
Chart 2.10 Pinout for CE6000.
CE6000 connects directly to an analogue port of the TA7000 thru a shielded 3-
pair cable with the following pinout:

alnloin|l2a|o|e(N|o|o|sw|o (=
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SUBD 15 FEMALE TO CE6000 SUBDS MALE TO TA7000
1

OB [(WIN
N|O|©O|O|W|W(~|O

—_ =
N|—

Chart 2.11 Pinout TA7000 - CE6000.

Cable to use is COMELDAT TP(D)V 3x2x0.38.

- TP6000 and TP8000 =» Analogue user panels with a male 9-pin SUBD
connector that connects to matrix with the following pinout:

SUBD 9 MALE FUNCTION TP6000
1 Data -
Data +
GND
OUT analog audio -
OUT analog audio +
GND
IN analog audio -
IN analog audio +
GND
Chart 2.12 Pinout of TP6000.

OO |N[(O|O A~ |WIN

Panels connect directly to an analogue port of the TA7000 thru a shielded 3-pair
cable with the following pinout:

SUBD 9 FEMALE TO TP6000 SUBD9 MALE TO TA7000

OO |NO|O~|WIN|—
WO |IN|WO |~ [WwiN|[—

Chart 2.13 Pinout TA7000 - TP6000.
Cable to use is COMELDAT TP(D)V 3x2x0.38.
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- YAESU 8100 = Wireless Base Station with two XLR connectors (male is
output, female is input) and the following pinout:

XRL MALE FUNCTION FT-8100
1 GND
2 OUT analog audio +
3 OUT analog audio -

Chart 2.14 Pinout for Base Station.

XRL FEMALE FUNCTION FT-8100
1 GND
2 IN analog audio +
3 IN analog audio -

Chart 2.15 Pinout for Base Station.

Base station connects directly to an analogue port of the TA7000 thru a
shielded 2-pair cable that separates into the two XLR input/output connectors. This is
the pinout:

XLR FEMALE TO FT-8100 SUBDY MALE TA7000
1 3
2 5
3 4
XLR MALE TO FT-8100
1 3
2 8
3 7

Chart 2.16 Pinout TA7000 and Base Station FT-81

o

0.

- Vertex Standard VXR-7000 =» Repeater for Walkie Talkie with analogue
RJ45 connector:

RJ45 LINE FUNCTION VXR-7000
1 Squelch +

2 Squelch -

3 OUT analog audio +
4 OUT analog audio -
5 IN analog audio +
6

7

8

[

IN analog audio -
TX Key Mic+
TX Key Mic-

hart 2.17 Pinout — repeater station.
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This station connects directly to an analogue port of TA7000 thru a FTP 8-wire
twisted pair CAT5. One end has a RJ45 connector and the other a male SUBD9:

RJ45 SUBDY9 MALE TA7000
3 5
4 4
5 8
6 7

Chart 2.18 Pinout TA7000 - VXR-7000.

i &
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EREaitif -

1RaALE Thidnbie 5. oo crnnge
: ! 1 = ] i 2

me | l' ol i f‘ a0
» W &
e

hom e ol o

TSESTED PAR ESES /I

PP Lt ) S P L LY. -

Chart 2.23 Pinout TA7000 — Repeater station.
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2.4.3 INTERFACE FOR PSTN LINES TA7002

They are FXO interfaces to PSTN line. With two ports, we must bring two cable
from the rear panel of the board to the matrix.

There are two types of rear panels (each one fills two slots):

- Single - for one board. With two RJ45 connectors (to matrix), two female
SUBD9 connectors (analogue 1/0Os) and two RJ11 telephone connectors.

- Double - for two boards (two TA7002). With 4 RJ45 connectors, two RJ11
telephone connectors and one female SUBD62 connector.

{:}l ---.-.-.- o e

analogd port 0

.

h :

line O

SRR

analog port 1

.

h :

lire 1

Figure 2.24 Rear single panel TA7002.

The double rear panel can fit two TA7002. The TA7004 board is compatible so
one of each can be inserted into a double rear panel.

NB: At the rear panel, RJ11 connector labelled as ‘line 0’ is associated to digital ‘port 1’

and RJ11 connector labelled as ‘line 1’ is associated to digital ‘port 0’, that is, PSTN
lines must be “crossed” with the digital ports.
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Figure 2.25 Double rear panel TA7002.

Connectors are associated to its functions:

-  PORT = RJ45 Connector to the matrix. With the same pinout that the

panels TP7000 (Page 16).

- LINE = RJ11 Connector for PSTN lines. Used pins are the central ones.

- ANALOGUE = SUBD9H Connector (single rear) and SUBD62H connector (double
rear) for Auxiliary Analogue Input/Output. It can be used for connecting to the
analogue intercom TB6000 or to send/receive the telephone audio in analogue

format.

The pinout for the SUBD9 connectors is:

SUBD9 FEMALE

FUNCTION TA7002

1

DATA -

DATA +

GND

IN analog audio -

IN analog audio +

Source +20v

OUT analog audio -

OUT analog audio +

OO |N[O|OI~]|W(N

Source —20v

Chart 2.19 Pinout for analogue connector: SUBD9.
Pins 1 and 2 are reserved for remote control thru RS-485, so there’s no need

for connecting them.

For the SUBD62 connector (double rear), this is the pinout for the digital ports

(from 0 to 3):
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PIN FUNCTION PIN FUNCTION PIN FUNCTION
TA7002 TA7002 TA7002
1 Data—0 22 GND 43 Data — 2
2 Data + 0 23 GND 44 Data + 2
3 24 GND 45
4 In Audio + 0 25 46 In Audio + 2
5 In Audio — 0 26 GND 47 In Audio — 2
6 27 GND 48
7 Out Audio + 0 | 28 GND 49 | Out Audio + 2
8 Out Audio—0 | 29 50 | Out Audio -2
9 30 51
10 Data — 1 31 GND 52 Data -3
11 Data + 1 32 GND 53 Data + 3
12 33 GND 54
13 In Audio + 1 34 55 In Audio + 3
14 In Audio — 1 35 56 In Audio — 3
15 36 GND 57
16 Out Audio + 1 37 GND 58 | Out Audio + 3
17 Out Audio — 1 38 59 | Out Audio-3
18 GND 39 GND 60 GND
19 40 61 + 20v Vout
20 + 20v Vout 41 + 20v Vout 62 - 20v Vout
21 - 20v Vout 42 - 20v Vout - -

Chart 2.20 Pinout: SUBD62.

Each digital port is connected to its analogue channel (In / Out audio) and its
telephone number.
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2.4.4 INTERFACES FOR PHONESETS TA7004

They are interfaces (FXS) for phonesets (conventional or DECT). With two
ports, we must bring one cable to the matrix per each port.

There are two types of rear panels (each one fills two slots):

- Single - for one board. With two RJ45 connectors (to matrix), two female
SUBD9 connectors (analogue 1/Os) and two RJ11 telephone connectors.

- Double - for two boards (two TA7002). With 4 RJ45 connectors, two RJ11
telephone connectors and one female SUBD62 connector.

{:}l ---.-.-.- o e

analogd port 0

.

h :

line O

SRR

analog port 1

.

h :

lire 1

Figure 2.26 Single rear TA7004.

The double rear panel can fit two TA7002. The TA7004 board is compatible so
one of each can be inserted into a double rear panel.

NB: At the rear panel, RJ11 connector labelled as ‘line 0’ is associated to digital ‘port 1’

and RJ11 connector labelled as ‘line 1’ is associated to digital ‘port 0’, that is, PSTN
lines must be “crossed” with the digital ports.
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Figure 2.27 Double rear TA7004.

Connectors are associated to its functions:

- PORT = RJ45 Connector to the matrix. With the same pinout that the

panels TP7000 (Page 16).

- LINE = RJ11 Connector for PSTN lines. Used pins are the central ones.

- ANALOGUE = SUBD9H Connector (single rear) and SUBD62H connector (double
rear) for Auxiliary Analogue Input/Output. It can be used for connecting to the
analogue intercom TB6000 or to send/receive the telephone audio in analogue

format.

The pinout for the SUBD9 connectors is:

SUBD9 FEMALE

FUNCTION TA7004

DATA -

DATA +

GND

IN analog audio -

IN analog audio +

Source +20v

OUT analog audio -

OUT analog audio +

OO |IN[oO|O |~ |W(N|—

Source —20v

Chart 2.21 Pinout for female SUBD9.
Pins 1 and 2 are reserved for remote control thru RS-485, so there’s no need

for connecting them.

For the SUBD62 connector (double rear), this is the pinout for the digital ports

(from 0 to 3):
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PIN FUNCTION PIN FUNCTION PIN FUNCTION
TA7004 TA7004 TA7004
1 Data—0 22 GND 43 Data — 2
2 Data + 0 23 GND 44 Data + 2
3 24 GND 45
4 In Audio + 0 25 46 In Audio + 2
5 In Audio — 0 26 GND 47 In Audio — 2
6 27 GND 48
7 Out Audio + 0 | 28 GND 49 | Out Audio + 2
8 Out Audio—0 | 29 50 | Out Audio -2
9 30 51
10 Data — 1 31 GND 52 Data -3
11 Data + 1 32 GND 53 Data + 3
12 33 GND 54
13 In Audio + 1 34 55 In Audio + 3
14 In Audio — 1 35 56 In Audio — 3
15 36 GND 57
16 Out Audio + 1 37 GND 58 | Out Audio + 3
17 Out Audio — 1 38 59 | Out Audio-3
18 GND 39 GND 60 GND
19 40 61 + 20v Vout
20 + 20v Vout 41 + 20v Vout 62 - 20v Vout
21 - 20v Vout 42 - 20v Vout - -

Chart 2.22 Pinout for SUBD62.

Each digital port is connected to its analogue channel (In / Out audio) and its
telephone number.
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2.4.5 RDSI G.722 PRONTO2 TA7001

It’s an interface for Pronto2 (the 2-port ISDN Audiocodec, which uses G.722
protocol) with four ports for four B channels.

TA7001 connects to the RJ45 labeled as “/ISDN S/T” for remotely controlling the
calling and converting into digital the audio.

There are two types of rear panels (each one fills two slots):

- Single > for one board. With four RJ45 connectors (to matrix) and four
female SUBD9 connectors (analogue 1/Os) for Pronto2.

- Double - for two boards (two TA7001). With 8 RJ45 connectors and one
female SUBD62 connector for Pronto2.

REMOTE COMTROL T
ALIDIO CHAMNEL 0 Qe w0 PORTO

.

(=]
1% PROMNTO 2 ANALOG ALIDIO 0

ALDIC CHAMMEL 1 — PP TITTT

e} PR o3 PORT 1

ARALCS AL 1

.

REMOTE CONTROL __,
ALUDIO CHANMEL 2 PP,
2° PRONTO2 2w omow ow O

AMSLOG SUDIC 2

PORT 2

.

ALDID CHAMREL 3 —

o PORT 3

o

ANSLOG AUDIC 3

:
:

Figure 2.28 Single Rear Board of TA7001.
Connectors form two groups:

- PORT = RJ45 Connector for connecting to the digital matrix. Pinout is the
same that panels (pin to pin).

- ANALOGUE AUDIO=» Female 9-pin SubD Connector for the analogue 1/O
and remote control of Pronto2.
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Connection is done thru twisted 8-wire FTP CAT 5 with RJ45 connectors. Max
distance to matrix: 300m.

Analogue connectors with even numbers (‘ANALOG AUDIO 0’ and ‘ANALOG
AUDIO 2’) will handle one Pronto2:

SUBD9 FEMALE(0,2) | FUNCTION TA7001 INTERFACE
1 RX 232

2 TX 232

3 GND

4 IN analog audio -

5 IN analog audio +

6

7

8

9

Reserved Source +20v
OUT analog audio -
OUT analog audio +
Reserved Source —20v
Chart 2.23 Pinout for Female SUBD9 connector.

Analogue connectors with odd numbers (‘fANALOG AUDIO 1’ and ‘ANALOG
AUDIO 3’) will handle the other Pronto2:

SUBD9 FEMALE(1,3) | FUNCTION TA7001 INTERFACE
1 Reserved

2 Reserved

3 GND

4 IN analog audio -

5 IN analog audio +

6

7

8

9

Reserved Source +20v
OUT analog audio -
OUT analog audio +
Reserved Source —20v
Chart 2.24 Pinout for Female SUBD9 connector.
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Figure 2.29 Double Rear TA7001.

The following pinout (62-pin SUBD) allows the connection of up to four

Audiocodecs:

PIN FUNCTION PIN FUNCTION PIN FUNCTION
TA7001 TA7001 TA7001

1 RX232 0 22 RX232 4 43 In Audio + 4

2 TX232 0 23 TX232 4 44 In Audio — 4

3 In Audio + 0 24 | Out Audio—0 | 45 | Out Audio—4
4 In Audio — 0 25 | Out Audio+0 | 46 | Out Audio + 4

5 In Audio + 1 26 GND 47 In Audio + 5

6 In Audio — 1 27 GND 48 In Audio — 5

7 Reserved 28 | Out Audio—5 | 49 Reserved

8 Reserved 29 | Out Audio+5 | 50 Reserved

9 Out Audio — 1 30 | Out Audio + 1 51 In Audio + 6
10 In Audio + 2 31 GND 52 In Audio — 6
11 In Audio — 2 32 GND 53 RX232 6
12 RX232 2 33 | Out Audio—6 | 54 TX232 6
13 TX232 2 34 | Out Audio +6 | 55 In Audio + 7
14 | Out Audio—2 | 35 | OutAudio+2 | 56 In Audio — 7
15 In Audio + 3 36 GND 57 Reserved
16 In Audio — 3 37 GND 58 Reserved
17 Reserved 38 | Out Audio—7 | 59 | Out Audio +7
18 Reserved 39 GND 60 GND

19 | Out Audio—3 | 40 | Out Audio+3 | 61 + 20v Vout
20 + 20v Vout 41 + 20v Vout 62 - 20v Vout
21 - 20v Vout 42 - 20v Vout - -
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Chart 2.25 Pinout for SUBD62 connector.

The connectors at the Audiocodec’s end are of XLR type:

QUTPUT IMPUT

— ()

LR MALE ¥LR FEMALE
Figure 2.30 XLR Connectors of Pronto2.

Pronto2 has two audio channels: channell (left side) and channel2 (right side):

- Channell = with two XLR connectors (female-input and male-output).
Following pinout:

CHANNEL 1 LEFT
XLR MALE OUTPUT XLR FEMALE INPUT
1 GND 1 GND
2 OUT analog audio + 2 IN analog audio +
3 OUT analog audio - 3 IN analog audio -

Chart 2.26 Pinout for channel 1.

- Channel2 =& with two XLR connectors (female-input and male-output).
Following pinout:

CHANNEL 2 RIGHT
XLR MALE OUTPUT XLR FEMALE INPUT
1 GND 1 GND
2 OUT analog audio + 2 IN analog audio +
3 OUT analog audio - 3 IN analog audio -

Chart 2.26 Pinout for channel 2.

Interface for control (RS232) is done thru the female SUBD9 connector of the
Pronto2:

SUBD9 FEMALE FUNCTION PRONTO2
1 Reserved

Tx 232

Rx 232
Reserved

GND

Reserved
Reserved
Reserved
Reserved
Chart 2.28 Pinout for control (SUBD9 connector).

OO |IN(O|OH~|WIN
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Figure 2.31 Connection for two Pronto2 Audiocodecs to one TA7001 with single rear.

Check the above figure and notice that the cable that connects the analogue
audio from the even port of TA7001 to the channel 1 of Pronto2 Audiocodec also
carries control data to the SubD connector. See below the pinout:
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XLR LEFT MALE TO PRONTO2 SUBD9 MALE TO TA7001

1 3

2 8

3 7

XLR LEFT FEMALE TO PRONTO2

1 3

2 5

3 4

SUBD9 MALE TO PRONTO2
2
3

5 3

Chart 2.29 From channel 1 of Pronto 2 to the TA7001.

N[ —

The other cable (from odd port of TA7001 to the channel 2 of Pronto2
Audiocodec) has this pinout:

XLR RIGHT MALE TO PRONTO2 SUBD9 MALE TO TA7001
1 3
2 8
3 7
XLR RIGHT FEMALE TO PRONTO2
1 3
2 5
3 4

Chart 2.30 From channel 2 of Pronto 2 to the TA7001.

In case of double rear panel, audio and control data for both Pronto2 units goes
thru the SubD62 connector. For pinout see chart 2.25.
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Figure 2.32 Connection for two Pronto2 units to one TA7001 with double rear panel.
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2.4.6 RDSI G.711 TD7000

It’s the interface for ISDN lines (G.711) with two digital ports for connecting to

the matrix.

So it’s capable of keeping two independent communications with one ISDN line
or two communications with two ISDN lines; selected by soldering jumper:

IZDN BOARD

[1111]

%,

=000 000 &

000 000 &

Z,

o
o

g ﬁ { LINE ISDH

= = 2 CHANNELS B

i AREUSED

O d

3 3

5 LINES [5DN DIFERENTS
i 4CHANNELS B

i i 1 CHANNEL B FOR
B LINE IS USED

Figure 2.33 Selection of one or two ISDN lines.

If two ISDN lines chosen, there must be two independent connections between
the ISDN lines and the TD7000: “ISDN 0” is for port 0, “ISDN 1~ is for port 1.

By default, the configuration is two ports for the same ISDN line (the common
use), so only one conection between the RJ45 connector labeled as “ISDN 0” and the
ISDN line should be connected. Please note that this solution does not imply only one
number because each of the two B channels of the ISDN line may have a different

dialling number.

There are two types of rear panels (each one fills two slots):

- Single > for one board. With two RJ45 connectors (to matrix), two RJ45
connectors (to ISDN lines) and two female SUBD9 connectors (analogue
aux 1/Os).

- Double > for two boards. With four RJ45 connectors (to matrix), four RJ45
connectors (to ISDN lines) and one female SUBD62 connectors (analogue
aux 1/Os).
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Figure 2.34 Single Rear Board - TD7000.

The analogue connector works at four wires without transformer. This is the
pinout:

SUBD9 FEMALE FUNCTION TD7000
1 DATA -
DATA+
GND
IN analog audio -
IN analog audio +
Source +20v
OUT analog audio -
OUT analog audio +
Source —20v
Chart 2.31 Pinout for SUBD9

OO |NO|OA|WIN

There is no need to connect pins 1 and 2 as they are used for external remote
control thru RS-485.

Connection is done thru twisted 8-wire FTP CAT 5 with RJ45 connectors. Max
distance to matrix: 300m.

The double rear board groups four digital ports:
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Figure 2.35 Double Rear TD7000.
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PIN FUNCTION PIN FUNCTION PIN FUNCTION
TD7000 TD7000 TD7000
1 Data-0 22 Data -2 43 In Audio + 2
2 Data + 0 23 Data + 2 44 In Audio — 2
3 In Audio + 0 24 | Out Audio—0 | 45 | Out Audio-2
4 In Audio — 0 25 | Out Audio+0 | 46 | Out Audio + 2
5 Reserved 26 GND 47 Reserved
6 Reserved 27 GND 48 Reserved
7 Reserved 28 Reserved 49 Reserved
8 Reserved 29 Reserved 50 Reserved
9 Reserved 30 Reserved 51 In Audio + 3
10 In Audio + 1 31 GND 52 In Audio — 3
1 In Audio — 1 32 GND 53 Data—3
12 Data — 1 33 | Out Audio—3 | 54 Data + 3
13 Data + 1 34 | Out Audio+3 | 55 Reserved
14 | Out Audio — 1 35 | Out Audio + 1 56 Reserved
15 Reserved 36 GND 57 Reserved
16 Reserved 37 GND 58 Reserved
17 Reserved 38 Reserved 59 Reserved
18 Reserved 39 GND 60 GND
19 Reserved 40 Reserved 61 + 20v Vout
20 + 20v Vout 41 + 20v Vout 62 - 20v Vout
21 - 20v Vout 42 - 20v Vout - -

Chart 2.32 Pinout for SUBD62.
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There are four RJ45 connectors for the digital matrix (labeled as ‘ports [0..3]’)

and other four RJ45 connectors for the ISDN lines (labeled as ‘isdn [0..3]’). The pinout
for the ISDN lines is as follows:

TOR WIEWN “IIII“ 1 Mo eannect
12345678 2 Mo connect

PR 3 Tx+

[ q Fowe-

o S R+

! I RJ45

I I E Tx-

— ¥ Mo connect

[S0OM LINE

Figure 2.36 Pinout for ISDN.
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2.4.7 GSM TD7001

It's the board for GSM lines (900Mhz and 1800Mhz bands). A Smart Card (not
provided, as the user must choose their preferred operator) must be inserted in the
slot.

The antenna is provided and must connected to its connectos at the rear board.

There are two types of rear panels (each one fills two slots):

- Single > for one board. With one RJ45 connector (to matrix, pinout is
similar to the panels’), one BNC connectors (to antenna) and one female
SUBD9 connectors (analogue aux 1/Os).

- Double = for two boards. With two RJ45 connectors (to matrix), two BNC

connectors (to antenna) and one female SUBD9 connectors (analogue aux
I/Os).

AMTEMNA,

PORT

Figure 2.37 Single Rear Board TD7001.

Connection is done thru twisted 8-wire FTP CAT 5 with RJ45 connectors. Max
distance to matrix: 300m.

There is no need to connect pins 1 and 2 as they are used for external remote control
thru RS-485.
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SUBD9 FEMALE

FUNCTION TD7001

1

DATA-

DATA+

GND

IN analog audio -

IN analog audio +

Source +20v

OUT analog audio -

OUT analog audio +

OO |NO|O|A|WIN

Source —20v

Chart 2.33 Pinout for SUBDS (single rear).

ANTENNA,
1 0
o [
PORT O
TITIT
o | U] | o
=t LLLLLI =
g o
3 -z
ey PORT 1 F

Figure 2.38 Double rear board TD7001.

The Smart card must be inserted into the slot at the fron panel or inside, at the
GSM module. Before switching on the power supply of the frame rack, the SIM card
must be inserted. If not, the rack frame must be switched off, the card slotted and the
rack frame switched on again. See below:

Page 48

Digital Intercom



TB7000
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INSERT TELEFHOMNE SMART CARD

Figure 2.39 SIM insertion into the GSM module

Such card might be of any GSM operator working at 900 or 1800 Mhz. It is
advised to insert the card (external or internal, but not both) and leave it there to avoid

non-recognition in case of switching off.

NB: The card shouldn’t ask for PIN number. If so, the intercom system cannot

recognise it.

NB: Never extract the card with the power on. Permanent damage may occur.
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2.5 AUTONOMOUS UNITS

They are autonomous interfacing units (not boards to be inserted into the rack
frame).

2.5.1 VoIP TI7011

This interface offers one communication channel (Voice-Over-1P) that may be
used with a remote panel or other remote equipments.

For connecting to the Digital TB7000 use twisted 8-wire FTP CAT 5 with RJ45
connectors (max distance to matrix 300m). For connecting to the Digital TB6000 use
shielded three-pair cabling with 9-pin SUBD connectors.

AHALOG PORTS DICITAL PORTS

a BOWER

oo 3 ELSIEJIEDNTEDL NIT L B
spsd P g 0 a5 EE

Figure 2.40 Rear panel TI7011

So far only one communication channel (analogue port 0, digital port 0) is
allowed, but there are four connectors available for future upgrades.

Se below the pinout for analogue connector:

SUBD9 MALE TW7000
1 DataControl-
DataControl+
GND
OUT analog audio -
OUT analog audio +
GND
IN analog audio -
IN analog audio +
GND

Chart 2.34 Pinout for analogue connector.

OO |INO|O |~ |WIN
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There’s a female 9-pin SubD connector for firmware upgrades thru RS232 with
the following pinout (notice that the cable to the COM port of the PC is pin-to-pin):

SUBD9 FEMALE TW7000
1 -
2 TX data
3 RX data
4 -
5 GND
6 -
7 -
8 -
9 -

Chart 2.35 Pinout for firmware connector.

For Ethernet connection plug a RJ45 to the connector labeled as ‘net’. The
systems allows a 10Mb/s communication using I[P address (by default is
192.168.8.222), but the user may change it (as well as the mask for providing net
visibility).

Before switching on the equipment, these parameters (IP address, ports) must
be configured. For this, use control port (RS232) thru ‘hyperterminal Windows
programme. Assign the following values using the serial port COM1:

Propiedades de COM1

“I-:Eunf-i-guraci-ﬁn de pLiErto

Bitz por segunda; I3Bi1|:||:| :;
Bitz de datos: . g 3 v::
Paridad: Mum - - \:

Bits de parada: |1 jv
Cantral de fuja: |v.

[ Restaurar predeterminados ]

[ Aceptar l [ Eancelar] [ Aplicar ]

Figure 2.41 Hyperterminal values.
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After configuring COM port of the PC as above, open the connection. Press
Enter and it’ll appear the function menu of the T17011. Check cabling and connection if
the menu does not appear. Once menu’s on screen, choose option ‘0 - Modo Boot,
insert password (3210), then choose option ‘4 - Configurar los parametros de red'.
Once parameters have been inserted (and without switching off the equipment), press
option ‘0 - Modo User’ so as the chosen parameters are validated.

One external power supply is provided with the equipment. There’s a redundant
PS as an option.

IMPORTANT: Minimim bandwidth required by the equipment is 100Kb/s. If less,
communication will not be fluid enough and data errors may appear.

2.5.2 TALLYS GP7020

Powered by an external power supply (+15v) provided with the equipment.
There’s a redundant PS as an option. See the two jack connectors below. It's advised
to use the cable fixers above them, so as to avoid accidental disconnetion.

O ) O
cable fixer port
digital
povvEr  posYer GPOUT GPIN tallys - Bl port analog
& o€ i ) Fre = e o o

Picture 2.42 Rear panel GP7020

For connecting to the Digital TB7000 use twisted 8-wire FTP CAT 5 with RJ45
connectors (max distance to matrix 300m). Cable is pin-to-pin as follows:

green-wwhite

green
browen-wehite

orange-white
brovwn

bronwen-wwhite
blue
blug-wwhite
orange

green
orange-white
blue-white
orange
brawen

green-white
hilue

12345678
| o .

i
(5]
T
| &=
IU’:
[=1]
-
[=1]

R |

r_

—-—— =
1

- -

ol
1 1
RJ4a FJ45 1 I
I I
L1

MATRIX TERMINAL PANNEL
DATA-AUDIO
| I

Picture 2.43 Pinout for conecting the GP7020 to the matrix.

[
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There’s an analogue connector for integrating the equipment to the analogue
intercom TB6000. It might be used in future upgrades.

If the equipment is connected to the digital and analogue intercom systems at
the same time, there will be GPIOs programmed from Indico software (TB7000) and
others from the analogue TB6000. it’s advised not to programme the same GPIO key
at both systems.

The analogue connection is done thru the 9-pin male SubD connector with the
following pinout:

SUBD9 MALE FUNCTION GP7020
DATA -
DATA +

GND
Reserved
Reserved

GND
Reserved
Reserved

GND

Chart 2.36 Pinout for analogue port.

OO |NoO|OA~|WIN|—

Tally Input is done thru a high density female 62-pin SubD connector with 20
opto-isolated inputs with no ground contact (so an alectrical isolation between systems
is established).

Each input has two balanced pins, one for the max positive voltage (IN+), the
other for the max negative voltage (IN-). Max input cannot go above +48v at each pair
of inputs and below +5v.

(+5v < Input < +48v)

There’s a +15-volt supply with GND connection (not by default) in case the
external equipment outputs are of contact closure type.

PIN FUNCTION PIN FUNCTION PIN FUNCTION
GP7020 GP7020 GP7020

1 +15v 22 INO+ 43 +15v
2 IN1+ 23 INO- 44 IN2+
3 IN1- 24 GND 45 IN2-
4 GND 25 IN3+ 46 GND
5 IN4+ 26 IN3- 47 IN5+
6 IN4- 27 GND 48 IN5-

7 GND 28 IN6+ 49 GND
8 IN7+ 29 ING- 50 IN8+
9 IN7- 30 GND 51 IN8-
10 GND 31 IN9+ 52 GND
11 IN10+ 32 INO- 53 IN11+
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12 IN10- 33 GND 54 IN11-
13 GND 34 IN12+ 55 GND
14 IN13+ 35 IN12- 56 IN14+
15 IN13- 36 GND 57 IN14-
16 GND 37 IN15+ 58 GND
17 IN16+ 38 IN15- 59 IN17+
18 IN16- 39 GND 60 IN17-
19 GND 40 IN18+ 61 GND
20 IN19+ 41 IN18- 62 +15v
21 IN19- 42 +15v - -

Chart 2.37 Pinout for female SUBD62 input connector.

The 20 outputs are programmable relays. Max voltage of switcher is 1000v DC.

PIN |FUNCTION PIN |FUNCTION PIN |FUNCTION
GP7020 GP7020 GP7020

1 +15v 22 OuUTOo+ 43 +15v

2 OUT1+ 23 OuT0- 44 ouT2+

3 OuUT1- 24 GND 45 OouT2-

4 GND 25 OUT3+ 46 GND

5 OuT4+ 26 OuTSs- 47 OuUTS+

6 OuT4- 27 GND 48 OuTs-

7 GND 28 OuT6+ 49 GND

8 OouT7+ 29 OouT6- 50 OouT8+

9 ouT7- 30 GND 51 ouTs-

10 GND 31 OuUT9+ 52 GND

11 OuUT10+ 32 OouT9- 53 OuT11+

12 OouT10- 33 GND 54 OuT11-

13 GND 34 OUT12+ 55 GND

14 OUT13+ 35 OouT12- 56 OUT14+

15 OuUT13- 36 GND 57 OuUT14-

16 GND 37 OUT15+ 58 GND

17 OuUT16+ 38 OuT15- 59 OuT17+

18 OuT16- 39 GND 60 OouT17-

19 GND 40 OuT18+ 61 GND

20 OuUT19+ 41 OuT18- 62 +15v

21 OuUT19- 42 +15v - -

Chart 2.38 Pinout for male SUBD62 output connector.

At the rear panel the user may also find an auxiliary tally I/O, programmable as
a key, for uses such as “on air”, switchers, etc. Inputs is activated by voltage (+12v),
output by contact closure.
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INPUT

QUTPUT

s

o
1

O
2

TALLY'S

CUTRUT:

1 OUT OM/OFF
2 0UT OM/OFF

Picture 2.44. Pinout for the aux tally I/O.
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2.6 MICROPHONY

2.6.1 MICROPHONE

Microphone is used for the user panels, whose front panels are provided with
female XLR connectors. User may change the standard configuration
(electret/condenser, with +10v Phantom supply) to a dynamic type by Jjumper
hardware’.

The preamplifier at the input can be configured for selecting the microphone
type, gain changes or even determine which contacts are active.

+10%
) %‘ ? )
+H10%

i O
e
FIt 2 + #LR
I: | | % (o MICROPHORE INPUT
R R

Picture 2.45 Preamplifier.

For having a dynamic microphone, see below the soldering jumper neede:
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+Y¥IMIC —]—aq

u1a

= HEES34aM
J1B R178
1901 l—”—|’ I
IG—l:I—- 4U7
? c1il
R171 R1E8 ——n
18K MIC+ TR ] cip
@A
T
= == 13R

12y

Picture 2.46 Dynamic microphone configuration.

For condenser, the configuration provided is as follows:

12y
cima []F 6+
U7 A6
+¥MIC At
RIS I
LK
ciz éeg o
qu? 415 Ris8
HiE- — B R 75mR
N7
R174 A1E7 ‘F‘
LBK 10K
MIC=

C113
4u?

J18
—
HIC+ —O
Jld
R171 ?
e Mg+

Picture 2.47. Condenser microphone configuration.

= 117

-12%

There are obsolete main boards in the market that cannot be changed as
ndicated above. The components to be soldered for the needed preamplifier are (see
the schematics of TP7000 provided with the CD):
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- U18 NE5534AN, SO8

- (C81,(C83,C65 100nF, 1206

- R149 732R, 1206

- R148 12R1, 1206

- R147 750R, 1206

- R146 44k2, 1206

- C79 220pF, 0805

- R72 1k, 1206

- R73 2k, 1206

- (€66, C67 10uF 16v, TANTALO-D

Also the following must be de-soldered:
- R72 at aside

- C65 at a resistor

- RAUX1 and RAUX2 under the board

In this case, headsets will need its own preamplifier to be incorporated.

If a mic input level gain is wanted (with any configuration), change R162 resistor
(33k) by a 68K one and C80 condenser (820pF) by a 390pF one, so doubling the gain.

If a mic input level decrease is wanted (with any configuration), change R162
resistor (33k) by a 15K one and C80 condenser (820pF) by a 1nF one, so halving the
gain.

Tensién (+Vmic) is +10v DC. If a change needed, check with Kroma engineers,
as resistor value of the internal power supply must be changed.

2.6.2 HEADSET

For rack-mounted user panels, headset input is for a 6,3-mm jack connector,
with the followinf assigned pins:

+10%

R 1 2 3
PIM 3 +
R F
PIM 1 GMND
PIM 2 SPEAKER

PR 310 Ml

Picture 2.48 Dynamic/Condenser Mic Configuration.
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The headset mic preamplifier is independent from the XLR mic one. This way
user may select the type of mic and tension modifying the headset input at the main
board. For the rack-mounted panels, see below the schematics:

ALTE
Laet

Picture 2.49. Headset input configuration.

For a dynamic headset mic, de-solder R96 resistor.

For doubling the mic gain (with dynamic or condenser mic), change R94 resistor
(from 33k to 68K) and C67 condenser (from 820pF to 390pF).

The desktop panel (TP7210) uses a Mini XLR (Tiny QG) connector at its rear,
withthe assigned pins as follows:

FRONT VIEW ”
CONECTOR ]]]]_
FEMALE FRONT SIDE
& 4. Green

MIC
1. GPIO {Not used) =0 5. Blue
2. Gnd (Not used)
3. Out_Ear- i
4. In_Mic+ BHEd
5. In_Mic- SPEAKER
6. Out Ear+ —{ 3. White

Picture 2.50 Desktop Panel Headset connector.
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The headset mic preamplifier is independent from the XLR mic one. This way
user may select the type of mic and tension modifying the headset input at the main
board. For this panel, see below the schematics:

+1T¥
[iF+]
E 4AT
a5
6
Guf

Rk g Lean

-12w

21
.
=
5

Picture 2.51. Desktop Panel Headset Input Configuration.

The standard configuration of desktop panel TP7210 is a condenser
microphone. If user may want a dynamic mic at the headset, solder the J4 jumper
(between pins 2 and 3) and de-solder J5 jumper.

Its rear panel is provided with potentiometers to adjust the gain of headset and
XLR mics with a ‘trimmer’.

MIC GAIN

{_
FRONTXR (@), { ¥ () HEADSET

Picture 2.52. Mic Input variations at the TP210.

The headset provided is monoaural with electrect input:
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MICROPHONE
TYPE ELECTRET

DIRECTIONALITY DIFERENTIAL, NOISE CANCELLING
POWER SUPPLY 3.3V

CURRENT DRAIN lcc = 400 uA max

SENSIVITY @ 1Khz (0dB=1V/ubar) Vs = -62 dB (+3dB)

FREQUENCY BANDWIDTH 300-3400 Hz

SPEAKER

TYPE ELECTRO-DINAMIC

IMPEDANCE @ 1Khz 300 O

SENSITIVITY @ 1Khz / TmW 106 dB SPL (+3dB)

FREQUENCY BANDWIDTH 300-3400 Hz

WEIGHT (with cable) 40g

Chart 2.39 Headset Tech Specs.

It’s the same headset forboth types of panels with two different connectors. See
below:

3. BUMIC (GREEN)

1
2
T[] oo
; 1. GROUMWD (WHITE-BELUE)

Picture 2.53 Headset for TP7100, TP7010, TP7016 user panels.
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YWHITE —__
GREEM —__
— »
I T -
BLUE ——

3. Out_Ear-. White
4. In_Mic+. Green
5. In_Mic-. Blue
6. Out_Ear+. Red

CONECTOR
FEMALE

FRONT VIEW

Picture 2.54 Headset for TP7210 desktop panel.
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3 FUNCTIONING

3.1 MASTER TM7000

It is the controlling unit. It handles up to 32x32 matrixes, which sums up to 128
crosspoints. For up to 1024 full crosspoint systems, use the Intercom Router Intercom
RL7124.

Its RAM keeps the active crosspoint map while its ROM has the saved 8 maps.
When changing to a different map, system takes 6-8 seconds to load the new charts
and send it to the panels.

cantral keys ]

———="
00

Picture 3.1 Front view of Master TM7000.

LCD

leds poweer
aooooon

Crosspoint maps are created by INDICO, the config programme provided. Its
defaul password is KROMA. Once edited, the map must be loaded into the system
either thru the floppy disk slot or the RS232 connection via a COM port of a laptop/PC.

Serial connection (second option above) allows a total control over the system,
so there’s no need to use the keyboard at the front panel. New crosspoints can be
created in real time, acting online with the active map.

There is a user nterface at the front panel (LCD and keyboard) for managing the
system and status checking as well. Its four keys are used as follows:

- OK = It validates the chosen option.

- Cancel = It cancels the chosen option or returns within the menu tree.
- =>=> It moves to the right the cursor.

- <==> It moves to the left the cursor.

The presentation screen shows the ative map and time of the system.

Digital Intercom TBJOO0D

[15:04] <MAP : DEHD>

Picture 3.2 Presentation screen at the Master LCD.
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Press OK to go to the main menu. First option is “Map management” menu.
Second is “Time/Date” of the system. Third, “System status”, Finally fourth is
“Engineering”, used for firmware upgradings.

= Hap HManagement <= Time fDate

System Status Engineering

Picture 3.3 Main Menu.

See below the ‘Map Management menu with its options:

= Active MAP <= Load Ha P

Erase HAP Backup HMnP

Picture 3.4 Map Management menu.

- Active Map => Press OK, choose the map to activate (among the eight
available) and press OK to activate it. Pressing OK again we return to the
main menu.

BAHR1-<EMPTY> BAHK3: <EMPTY>

=* BAHKZ: <DEMD> <= BAHKG: <EMPTY>

Picture 3.5 Map selection.
- Load Map => Used to save a map from a floppy disk. Press Ok to enter,
choose the file, then the bank to use. Should a map be already loaded in
that bank, it will be deleted.

- Erase Map => Use this command to delete maps. Use arrows to locate the
bank and then press OK.

- Backup Map => It saves a map onto a floppy disk. Use arrows to locate the
bank and then press OK.

Use the Time/Date Menu to set these parameters. Use the arrows to change
them. Then press OK:

Time/Date MHodify:

[15]:07

Picture 3.6 Time/Date menu.
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Entering "System Status’, user will find two options:

= Hatrix

Ports

Picture 3.7 System Status Menu.

“Matrix” for matrix status checking and “Ports” for ports status checking (those
being used at the active map).

According to the matrix model, the user will be informed about the different
crosspoint boards. The models are:

o TM7032 -> Matrix “0” with one Board “A”. It’s a 32-port matrix with
one 32x32 crosspoint board.

o TM7064 -> Matrix “0” and Matrix “1” with two boards “A” and “B” at
each matrix. It's a 64-port matrix which consists of two 32-port units.
Each of these two matrixes have one main crosspoint board and one
extension crosspoint board.

o TM7096 -> Matrix “0”, “1” and “2” with three boards “A”, “B” and “C”
at each matrix. It’s a 96-port matrix which consists of three 32-port
units. Each of these three matrixes have one main crosspoint board
and two extension crosspoint boards.

o TM7128 -> Matrix “0”, “1”, “2” and “3” with four boards “A”, “B”, “C”
and “C” at each matrix. It's a 128-port matrix which consists of four
32-port units. Each of these four matrixes have one main crosspoint
board and three extension crosspoint boards.

=» Matrix 0 [A][B] - OK <=

Matrizx 1 [AI[ 1 - ERROR

Picture 3.8 Example of Crosspoint Board Status Checking.

Picture above shows a 64-port matrix with its two 32-port units (each one has
two crosspoint boards). “A” Board is the master one and is “OK”; “B” is the extension
one and being detected only at the first matrix (“Error”).

At the port status checking option, user may see: port number, assigned label,
type of terminal/panel and its status, which can be:

- OK = The digital port works fine. Percentage shows the quantity of signals
that are being sent effectively. An 95+ (measured average) would indicate
right no errors.

- Warning = The panel/terminal assigned by Indico to the port does not

match the one detected by the matrix. Check the setting up and the
programmed ports.
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Error =& There is no connection with a configured port. Percentage’ll be 5-. At the
picture below, Port 1 shows some kind of error.

POOD [SOHI - Ta?000] OK C9&¥)

PO0O1 [REGI - TP7010] ERROR (1)

Picture 3.9 Example of port status checking.

3.2 MATRIX TM7032-64-96-128

TM7032 Matrix receives the audio and data signals from panels, interfaces...,
does the crosspoints according to Master unit commands as if a digital audio router.
That means that all terminals must be connected to the 32 RJ45 connectors at its rear

panel.

o -

/

I mm digital intercom syatem I

Picture 3.10 Front View of 32x32 Matrix.

This matrix has a 32x32 crosspoint board that communicates directly with the
master unit thru a data cable.

System is scalable adding 32-port matrixes: 64x64, 96x96 and 128x128, with
main crosspoint boards and extension boards. All matrixes are connected together to
share the audio signals.

See below the controls and indicators of the board:

1

2 3 = 4 3 —5— g
O] = 6l Bkl [Feond
1-2 1—137 1 5

Picture 3.11 Front view of the Crosspoint Board.

- 1 = It's a connector for firmware upgrades. Reserved for Kroma
engineering dept.

- 2 = Reboot. For reconfiguring the board. It takes 30 seconds to become
operative.

- 3 = Green leds for power indication. When switched on, both must be lit:

o 3.1 =>+5v supply
o 3.2 =>+3.3v supply
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- 4 = Green leds for micro-controller status:

o 4.1 => If flickering, there’s a configuration error (board remains un-
opearive). As it can be temporary, switch off and on. When no light, it
incicates normal functioning.

o 4.2 =>It"s on only during the initial configuration (30 seconds).
o 4.3 =>Working. If flickering, micro-processor is operative.
- 5 =» Red Leds for ports and control.

o 5.1 => If flickering at the main XPT board, there’s a terminal asking
for communication. The same led at the extension XPT should be
off.

o 5.2 => If flickering at the main XPT board, it shows normal RX/TX
activity between matrix and master. If not flickering, master is not
controlling the matrix. If flickering at the extension XPT, it shows
normal RX/TX activity between main and extension boards.

o 5.3 => If flickering at the main XPT board, there’s synchro clocking
being received from the master unit. If not flickering, there’s a
connection problem with the Master (boards remains un-operative).
If flickering at the extension XPT board, multiplex is being normally
received (in 32+ port configurations).

o 5.4 => If flickering at the main XPT board, extension is being
normally received (in 32+ port configurations). If flickering at the
extension XPT board, extension is being normally received.

o 5.5 => If flickering at the main XPT board, matrix is asking for
communication with a terminal. The same led at the extension XPT
should be off.

- 6 = Extractor. It extracts the PCB board by pressing it to the right side.
A crosspoint board can be either Main (A; it sends the audio multiplex to the

assigned ports) or Extension (B, C, D: they receives the audio multiplex from other
matrixes in 32x port configurations). They are located as follows:

=] L
[ |
o C
e ] |

RPT'S MATREK

Picture 3.12 XPT Boards at 128x128 matrix.

NB: NEVER EXTRACT XPT BOARD WHILE SWITCHED ON.
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Basic configuration consists of a Master TM7000 connected to a Matriz TM7032
so as to get a 32x32 configuration. One XPT board will be enough for this
configuration.

Mazter
= oo
- C—: o =1

contral <

= — =

1 main xpt )‘

Picture 3.13 XPT Board at Matrix TM7032.

=

Iatrix O

A Matrix TM7064 consists of 64 ports with two 32x32 matrixes connected to a
Master. Each matrix will have two crosspoint boards: the main one and the extension.

1 main xpt + 1 ext xpt v

Audio

Picture 3.14 XPT Boards at Matrix TM7064.

A Matrix TM7096 consists of 96 ports with three 32x32 matrixes connected to a
Master. Each matrix will have three crosspoint boards: the main one and two
extensions.

Cantral Cantral
. Audio
Matrix O Matriz 2

=S —0ex= = (S [E— =

= = =

Corntrol

Ao Audio
1 min xpt +2 et xpt Maitrix 1

Figura 3.15 Tarjetas XPT’s en Matriz TM7096.
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A Matrix TM7128 consists of 128 ports with four 32x32 matrixes connected to a
Master. Each matrix will have four crosspoint boards: the main one and three
extensions.

Cortrol Contral
hatrix O hatrix 3
Audio

= =

I
i

= = = =

Aucdio Cortral Control Audic

tatriz 1 Matriz 2

Audio
1 main xpt + 3 ext xpt

Picture 3.16 XPT Boards at Matrix TM7128.

For 128+ configurations, there are special groupings. There’s a router for
connecting different matrixes. Ask for more info.
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3.3 PANELS TP7000

3.3.1 BASIC TP7016

This is a 16-key panel, whose crosspoints and labels are configured thru
INDICO software. User must print them to be inserted into the key.

POWEE w= = AETY

MG

BOFTAL [NTERZEG TRFIHE

: DIGTAL AUX
= LI

EXTENSION ANALOG
| Ll

Picture 3.17 Front View TP7016.

On the left side we may find the analogue audio controls: a mic XLR input, a
headset jack connector, a mute key (with led) and two potentiometers (main audio, aux
audio). The two leds indicate power and matrix communication. The last one must be
flickering.

The microphone might be dynamic or electrect (switchable by jumper hardware,
see page 58). Polarization voltage is changeable (by default, it’s +10v).

Keys are configurable to activate the crosspoints with the following functions:

- Talk Only = Audio is sent from the panel to the destinastions (one way
only).

- Listen Only =» Audio is received from the source (one way only).

- Talk & Listen = Audio is sent and received. It's a two-way communication.

- Remote One Way =» The crosspoint is activated at a panel but is produced
between third parties (example: one user panel may activate the

communication between a beltpack and the CCUs). One way only.

- Remote Both Ways = The crosspoint is activated at a panel but is
produced between third parties. Talk & Listen.

- Remote Volume = It allows level changes (between —12dB and +12dB) at a
remote crosspoint.

- Volume + = To increase the volume of a local crosspoint (up to +12dB on a
+1dB basis on the incoming audio).
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Volume - = To decrease the volume of a local crosspoint (up to -12dB on a
-1dB basis on the incoming audio).

These volume keys will vary the volume of all the activated crosspoints at that
moment. This new level will be kept unless varied later. This command is de-activated
if not used in four seconds. Note that as this panel is not provide with bar graphs, audio
adjustment must be made “by ear”.

Crosspoint keys may work in three ways (software programmable):

PTT = Push to Talk, The assigned command will be activated only when
the key is kept pushed.

Latch = Just pressing once, command is activated. Press again for de-
activation.

Default mode =» Both ways at the same time. The command (crosspoint)
will be active by pressing once or keeping it pressed.

Each crosspoint key is provided with two leds (green and red):

Lit green =» the command assigned to that key has been activated.

Lit red =» it shows that another terminal has established communication with
this user panel (talk & listen).

Flickering green = It shows that the assigned command is being activated
(it might be a telephone call being established).

Flickering red = it shows that another terminal has established
communication with this user panel (listen only: we cannot talk until we
activate the command by pressing the key).

TECH SPECS:
Dimensions 1 unit high/19”, 150 mm deep
Weight 2,5Kg
Power supply +15v, 500mA external PS
Number of XPT keys 16
Mic preamplifier +50dB to +75 dB (input —63dB)
Speaker preamplifier 10w at 4Q
Signal format 44,1Khz sampling, 16 audio bits + 8 data bits
Connections RJ45 (digital)

SUBD9M (analogue)
Aux analogue I/O nominal level 4 dBv

Max level 12dBv
Bandwidth 150Hz-10kHz
SNR > 80 dB

THD < 0.2% a 4 dB
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3.3.2LCD TP7010

This is a 32-key user panel with double LCD for 4-character labels (configured
by Indico software). It allows local crosspoint management, so new commands can be
established in real time and saved onto the active map.

=Ts

=¥

BeRITAL IETERGER TETIND @

£ DIETAL AlE
157 TaLLY LK EXTENEIRN AHALOG

B ¢ [ e 2 [C

Picture 3.18 TP7010.

On the left side we may find the analogue audio controls: a mic XLR input, a
headset jack connector, a mute key (with led) and two potentiometers (main audio, aux
audio). One led indicates power.

The microphone might be dynamic or electrect (switchable by jumper hardware,
see page 58). Polarization voltage is changeable (by default, it’s +10v).

For label & command assignments, this user panel is provided with 31
crosspoint keys and one page-shifting key (totalling up to 124 assigned commands).

Keys are configurable to activate the crosspoints with the following functions:

- Talk Only = Audio is sent from the panel to the destinastions (one way
only).

- Listen Only = Audio is received from the source (one way only).
- Talk & Listen = Audio is sent and received. It's a two-way communication.
- Remote One Way =» The crosspoint is activated at a panel but is produced

between third parties (example: one user panel may activate the
communication between a beltpack and the CCUs). One way only.
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Remote Both Ways =» The crosspoint is activated at a panel but is
produced between third parties. Talk & Listen.

Remote Volume =» It allows level changes (between —12dB and +12dB) at a
remote crosspoint.

Volume + =» To increase the volume of a local crosspoint (up to +12dB on a
+1dB basis on the incoming audio).

Volume - 2 To decrease the volume of a local crosspoint (up to -12dB on a
-1dB basis on the incoming audio).

These volume keys will vary the volume of all the activated crosspoints at that
moment. This new level will be kept unless varied later. This command is de-activated
if not used in four seconds. Note that as this panel is not provide with bar graphs, audio
adjustment must be made “by ear”.

Prog = For local programming (crosspoint changes). Permanent saving
(onto permanent memory ROM) is available.

Pag. = For shifting between pages, so the phisical 31 crosspoint keys
become 124 virtual keys. Pag key is programmable so the user may have
32 phisical crosspoint keys when a Pag key is not programmed.

Crosspoint keys may work in three ways (software programmable):

PTT = Push to Talk, The assigned command will be activated only when
the key is kept pushed.

Latch =» Just pressing once, command is activated. Press again for de-
activation.

Default mode =» Both ways at the same time. The command (crosspoint)
will be active by pressing once or keeping it pressed.

Each crosspoint key is provided with two leds (green and red):

Lit green =» the command assigned to that key has been activated.

Lit red = it shows that another terminal has established communication with
this user panel (talk & listen).

Flickering green = It shows that the assigned command is being activated
(it might be a telephone call being established).

Flickering red = it shows that another terminal has established

communication with this user panel (listen only: we cannot talk until we
activate the command by pressing the key).
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NB: For local programming, assign a PROG command to a key.

Crosspoint changes are done easily from Indico software, so local programming
is advised when only a few new crosspoints must be created.

After pressing PROG, a menu will appear:

* Programming HMenu *

DEL SAVE

Picture 3.19 Programming menu TP7010.

- REPR = For key reprogramming. After pressin this key, the following menu
appears:

Select Kevy to Program

< Press a key >

Picture 3.20 Reprogramming Menu.

Press any key and then choose the key for the new assignment. Next, the
comand must be selected.

Select Command

{ Press a key >

Picture 3.21 Command selection.

Press any key and choose the command (Talk&Listen (T&L), Talk, Listen
(LSTN), Remote one way, (ROW), Remote both ways (RBW) and remote level
variation (RVL). Press the needed key to assign such command.

T&L TALK LSTH Row RBW RUL

ERIT

Picture 3.22 Command Selection menu.

Then choose the source and press any key:

Select Source
LY

% Press a key »

Picture 3.23 Source selection.
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Then the destination (if needed):

Select Destination

< Press a key >

Picture 3.24 Destination selection.

Press any key, then the key that shows the desired destination so as to
programme the new crosspoint:

* Programming HMenu *

DEL SAUVE

Picture 3.25 Programming Menu TP7010.

- DEL = Used for deleting command assignments. If pressed, the following
menu appears.

Select key to delete

€ Press a key >

Figura 3.26 Vista panel TP7010.

Press any key to see all the assignments. Then delete the chosen one.

- SAVE = It saves the changes to the active map (ROM) of the Master. If
changes have been done and this option is not activated, the new crosspoints wouldn’t
be kept when switched off the equipment.

- EXIT = To exit the menu and make the panel operational again.

TECH SPECS:
Dimensions 2 units high/19”, 150 mm deep
Weight 3,4 Kg
Power supply +15v, 500mA external PS
Number of XPT keys 32 (direct), 124 (when page-shifting)
Mic preamplifier +50dB to +75 dB (input —63dB)
Speaker preamplifier 10w at 4Q
Signal format 44,1Khz sampling, 16 audio bits + 8 data bits
Connections RJ45 (digital)

SUBD9M (analogue)
Aux analogue I/O nominal level 4 dBv
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Max level 12dBv
Bandwidth 150Hz-10kHz
SNR > 80 dB

THD < 0.2% a 4 dB

3.3.3 GRAPHIC TP7100

This is an advanced master panel that allows total control of the intercom
system in real time and thru a graphic display.

r THTERCOM
l.ll'.'r ALZ

MERDEET
@ tmoms BIBITAL WMTEREOH TRTI00 @

= DIGITAL A

15V TaLLY LINE EXTEMSION ANALOG
I OUT T

B [ e (e

Picture 3.27 Panel TP7100.

It is provided with 8 keys for direct commanding and ten pages to shift among.
So user may have 80 virtual crosspoint keys. It also has a dialling keypad.

On the left side we may find the analogue audio controls: a mic XLR input, a
headset jack connector, a mute key (with led) and two potentiometers (main audio, aux
audio). One green led indicates power.

The microphone might be dynamic or electrect (switchable by jumper hardware,
see page 58). Polarization voltage is changeable (by default, it’s +10v).

Keys are configurable to activate the crosspoints with the following functions:

- Talk Only = Audio is sent from the panel to the destinastions (one way
only).

- Listen Only = Audio is received from the source (one way only).

- Talk & Listen = Audio is sent and received. It's a two-way communication.
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- Remote One Way =» The crosspoint is activated at a panel but is produced
between third parties (example: one user panel may activate the
communication between a beltpack and the CCUs). One way only.

- Remote Both Ways = The crosspoint is activated at a panel but is
produced between third parties. Talk & Listen.

- Remote Volume <> It allows level changes (between —12dB and +12dB) at a
remote crosspoint.

- Volume + =» To increase the volume of a local crosspoint (up to +12dB on a
+1dB basis on the incoming audio).

- Volume - = To decrease the volume of a local crosspoint (up to -12dB on a
-1dB basis on the incoming audio).

These volume keys will vary the volume of all the activated crosspoints at that
moment. This new level will be kept unless varied later. This command is de-activated
if not used in four seconds. Note that as this panel is not provide with bar graphs, audio
adjustment must be made “by ear”.

Crosspoint keys may work in three ways (software programmable):

- PTT =» Push to Talk, The assigned command will be activated only when
the key is kept pushed.

- Latch = Just pressing once, command is activated. Press again for de-
activation.

- Default mode = Both ways at the same time. The command (crosspoint)
will be active by pressing once or keeping it pressed.

Each crosspoint key is provided with two leds (green and red):

- Lit green = the command assigned to that key has been activated.

- Lit red = it shows that another terminal has established communication with
this user panel (talk & listen).

- Flickering green = It shows that the assigned command is being activated
(it might be a telephone call being established).

- Flickering red =» it shows that another terminal has established

communication with this user panel (listen only: we cannot talk until we
activate the command by pressing the key).

It's the most advanced user panel because it allows a total control of the
intercom system in real time and thru a graphic display. It’s like a master panel.
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The dialling keypad is provided with control keys for the main menu (use the
optcal encoder to move between the different options):

- OK = It activates the selected option.

- CANCEL = It de-activates the selected option or go back to the previous
menu.

- VOL = For level variations of local crosspoints.

- PAG = For page-shifting.

KROMA
ga TELECOM

SYSTEM

Picture 3.28 Homepage TP7100.

It is provided with 3 control keys for local audio:
- Mic ON/OFF =» A mute-in key for the mic.

- Headset ON/OFF = Choose whether you want to use the headset or the
mic & built-in speaker.

- Speaker ON/OFF = A mute-out for the speaker.

HEADSET On,/Off [
MIC On/OffF |3
SPEAKER On/Off |3
KEY LOCK

Picture 3.29 Audio Icons.
And one key for locking the keyboard:
- KEY LOCK = It blocks all the keys of the user panel for safety reasons.
Without using Indico software, this panel can change the crosspoint
configuration of the whole system (including level variations). For the main menu, press

‘OK’ and then enter the ‘Security PIN’ (by default: ‘0000°). This authorized access
might ne de-activated as well.

KR Security PIM - )
K 1 (SVee
oK Cancel SYSTEM

Picture 3.30 Access to Menus.
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Main menu consists of:

- Crosspoint Management = For creating & deleting crosspoints.

Picture 3.31 Main menu.

After pressing it, the screen presents three distinct vertical sections: source,
type of crosspoint (plus its dB level) and destination. Use arrows (or optical
encoder) to move between options and press OK to select them. The types of
crosspoints are:

a) Not done. See below a crosspoint between Port1 and Port0 not done:

Picture 3.32 Crosspoint not done.

b) Done. See below a crosspoint between Port1 and Port0 done:

Picture 3.33 Crosspoint done.

c) Blocked. See below a crosspoint between Port1 and Port0 done and
blocked (it can be deleted only from this specific panel):

Picture 3.34 Crosspoint blocked.
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- Local Configuration = It allows the user to change the crosspoints of the
local panel, chage or activate the PIN function or save audio levels onto the
map.

Picture 3.35 Local configuration menu.

Press OK for having access to the submenus:

Picture 3.36 Config submenus.

a) XPT Key Config: for assigning crosspoints to the keys (each one of the eight
keys might have a different command according to the page the user is at
the moment). Press OK to proceed with the chosen key to be
reprogrammed.

Picture 3.37 XPT key configuration.

Then select the assigned command, the source and the destination:

Picture 3.38 Command assigning to XPT keys.
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PIN Options: It allows the user to change the security options (at the time of
switching on the panel). We have two options at “PIN request”: NEVER or
ALWAYS. User might also want to change the PIN number (which is “0000”
by default).

Picture 3.39 Security Options.

Save Keys to map: for saving the new assignments to the keys reconfigured
from the panel into the active crosspoint map (into ROM memory).

Save Audio Levels to map: for saving audio level assigned to crosspoints
reconfigured from the panel into the active crosspoint map (into ROM
memory).

System Status = For checking the status of matrixes and activated ports in
real time. It's useful for knowing which panel is connected to which port,
how each terminal and XPT board is working.

Picture 3.40 System Status Menu.

a) Matrix Status: For checking the functioning of each matrix and XPT
board, according to the matrix config (32x32, 64x64, 96x96 or
128x128). See below the different possibilities:

Picture 3.41 Status Matrix TM7032.
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Picture 3.42 Status Matrix TM7064.

Picture 3.43 Status Matrix TM7096.

Picture 3.44 Status Matrix TM7128.

b) Port Status: it shows the functioning of each assigned port in real
time: ‘OK’ means proper functioning. ‘ERROR’ means that the panel
is not connected or is switched off. ‘WARNING’ means that the
connected equipment is not the assigned one by the Config
programme Indico. In this last case, check configuration and
installation.

Picture 3.45 Port Status.

Active Map=>» For activating one of the eight maps saved at the master unit.

Page 82 Digital Intercom



TB7000

Picture 3.46 Map activation menu.

Select the map to activate and press OK:

Picture 3.47 Selection of XPT map.

- Dial Management = For making phone calls thru the available interfaces
(GSM, ISDN, PSTN...).

Picture 3.48 Status Matrix TM7128.

Press OK to access dialling menus. User’ll be able to manage external phone
calls (to receive them or to finish them) and modify phone numbers assigned to certain
keys with Indico software.

Picture 3.49 Dialling Menu.

a) Call Management: For establishing/finishing telephone calls. To make a call,
select the interface to establish the communication. It'll be as ‘IDLE’. And
then press OK.
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Dial Management
) P

PO0G G52
POOS 700z

Picture 3.50 Selection of dialling interface.

If the interface is being used by any other phone call, it’ll be indicated
with BUSY. If IDLE, it can be used for a new communcation. Press OK to start a
new phone call.

Dial Management
RT NAME VRE -

Picture 3.51 Starting a calll.

Press OK again and New Call Menu will appear. Then we must select
the type of codec (G.711 for PSTN and GSM, G.722 or G.711 for ISDN).

e Call
[ 1 Codec
5,711
k-l Cancel--Exit G722

Picture 3.52 Destination number.

Select the number window and press OK. Then enter the destination
telephone number and press OK. Select “OK-Call” and press OK to start
dialling.

Dial Management
T MAME TYPE STAT DIAL CoOD

IDLE -

Picture 3.53 Dialling.
To end a call, select the communication to interrupt (it must be in STBL

status). When shaded, press OK. It’ll appear a “Finish Call” message. Press OK
again.
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Dial Management

PODA 13 TOFO01

STAT

PODG 7002 TA7ZO0Z

Picture 3.54 Hanging up a call.

b) Modify Dial Entry: For modifying a number already assigned to a label
(directory). Press OK to enter the agenda. Select to number to modify:

Picture 3.55 Number modification.

Press OK and change the number.

Edlit Dial

|963264512

| Codec

»a.711<

Ok--Call

ancel--Exit 4,722

Picture 3.56 Destination number modifying.

TECH SPECS:

Dimensions

Weight

Power

Number of XPT keys
Mic amplifier
Speaker amplifier
Signal format |
Connection

Analogue 1/0

2RU/19”, 150 mm deep

3,4 Kg

+15v, 500mA external PS

8 XPT keys (80 if page-shifting), 20 control keys
+50dB to +75 dB (Input —63dB)

10w at 4Q

44,1Khz sampling, 16 bits audio + 8 bits data
RJ45 in digital

SUBD9M in analogue

Nominal level 4 dBv

Max level 12dBv

Bandwidth 150Hz-10kHz

SNR > 80 dB

THD < 0.2% at 4 dB
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3.3.4 DESKTOP TP7210

It's a desktop user panel with 16 XPT keys and LCD for label viewing (max 4
characters per key). It allows the user to repogramme local crosspoints in real time,
which can be saved into the active map.

User can page-shift in four pages, totalling 60 XPT virtual keys (with one for
changing the page). It can also manage phone calls thru the available interfaces. It has
a dialling keypad for direct dialling.

SYSTEM

e oicraLinTercom TR 7210

HEADSET

,,,,, AUX MIC GAIN
00‘ ANALOG o0

FROMNT HEAD

] DAL )

Picture 3.57 Panel TP7210.

On the left side we may find the analogue audio controls: a mic XLR input, a
headset jack connector (at the rear), a mute key (with led) and two potentiometers
(main audio, aux audio). One green led indicates power. Another shows proper matrix
communication (if flickering).

The microphone might be dynamic or electrect (switchable by jumper hardware,
see page 58). Polarization voltage is changeable (by default, it’s +10v).

Rear connector for headset is of Tiny Q-G type. By default a electrect mic is
provided (it’s changeable thru jumper hardware though).
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Rear panel is provided with potentiometers to headset & front mic gain
adjustment.

For switching between headset and local speaker, use the MIC key. When
using the headset, the MIC led will be on. MUTE can be used for “muting” both
microphones.

Keys are configurable to activate the crosspoints with the following functions:

Talk Only =» Audio is sent from the panel to the destinastions (one way
only).

Listen Only = Audio is received from the source (one way only).

Talk & Listen =» Audio is sent and received. It’s a two-way communication.
Remote One Way =» The crosspoint is activated at a panel but is produced
between third parties (example: one user panel may activate the

communication between a beltpack and the CCUs). One way only.

Remote Both Ways =» The crosspoint is activated at a panel but is
produced between third parties. Talk & Listen.

Remote Volume =» It allows level changes (between —12dB and +12dB) at a
remote crosspoint.

Volume + =» To increase the volume of a local crosspoint (up to +12dB on a
+1dB basis on the incoming audio).

Volume - = To decrease the volume of a local crosspoint (up to -12dB on a
-1dB basis on the incoming audio).

Pag. = For page-shifting.

These volume keys will vary the volume of all the activated crosspoints at that
moment. This new level will be kept unless varied later. This command is de-activated
if not used in four seconds.

Crosspoint keys may work in three ways (software programmable):

PTT = Push to Talk, The assigned command will be activated only when
the key is kept pushed.

Latch = Just pressing once, command is activated. Press again for de-
activation.

Default mode =» Both ways at the same time. The command (crosspoint)
will be active by pressing once or keeping it pressed.

Each crosspoint key is provided with two leds (green and red):

Lit green =» the command assigned to that key has been activated.
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Lit red =» it shows that another terminal has established communication with
this user panel (talk & listen).

Flickering green = It shows that the assigned command is being activated
(it might be a telephone call being established).

Flickering red = it shows that another terminal has established
communication with this user panel (listen only: we cannot talk until we
activate the command by pressing the key).

For entering menus and dialling, use the following keys:

ESC - it cancels the selected option or moves backwards in the menu
tree.

OK - it validates the action or moves forward in the menu tree.
‘2" > Digit 2 and up arrow.

‘8" - Digit 8 and down arrow.

‘6’ - Digit 6 and right arrow.

‘4’ > Digit 4 and left arrow.

Press OK for entering config and dialling menus:

Picture 3.58 Menu TP7210.

Key Reprogram =» For reprogramming local crosspoints: press OK to enter.
Then choose the key to reassign.

Picture 3.59 XPT reprogramming.

Select the needed command and press OK:

Picture 3.60 Command Selection.
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Press any key to go further. Now select destination port (if needed):

Picture 3.61 Destination selection.

If many crosspoint changes must be made, user may prefer Indico software
instead of local reprogramming.

- Dial Management - For dialling management thru the available interfaces:

Picture 3.62 Dialling menu.

Press OK and select the interface:

Picture 3.63 Interface selection.

Press OK to start a call:

* Mewy Call *

Picture 3.64 Start a call

Then enter the destination phone number:

Picture 3.65 Destination number.

Then select the audiocodec: G.711 for GSM, PSTN and ISDN, G.722 for ISDN
only:

Picture 3.66 Codec Selection.

Press OK to start the call (dialling status will appear):
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TELF

ISDM CALL  -—--

Picture 3.67 Start a call.

If user wants to hang up, select the interface in use and press OK. A “Finish
Call” message will appear: press OK again:

P FIMISHCALL 4

Picture 3.68 End a call.

- Save Config = It saves the changed crosspoints into the active map. If
modifications are temporary, user may prefer not to alter the active map.

- Exit =& TO leave config menu and make the panel operative.

NB: It’s advised that talk&listen keys are assigned to the telephone interfaces
(with no number assigned) so that they can be pressed when establishing the
communication. That way the person at the other side of the line will listen to and will

not be confused.

TECH SPECS:
Dimensions

Weight

Power

Number of XPT keys
Mic amplifier
Speaker amplifier
Signal Format
Connection

Analogue 1/0

265mm wide, 80mm high,

180mm deep

1,5 Kg

+12v, -12v, +5v 500mA external PS
16 direct (60 if page-shiftig), 20 control
+50dB at +75 dB (Input —63dB)

10w at 4Q

44,1Khz sampling, 16 bits audio + 8 bits data
RJ45 in digital

SUBD9M in analogue

Nominal level 4 dBv

Max level 12dBv

Bandwidth 150Hz-10kHz

SNR > 80 dB

THD < 0.2% at 4 dB
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3.7 INTERFACE BOARDS

These boards are plugged into the interface rack frame TR7000 and are
designed to proveide access to externals systems.

3.7.1 ANALOGUE TA7000, TA7003

They convert external analogue sources into digital signals compatible with
Kroma digital Intercom. TA7000 is for 4 wires. TA7003 is for two wires. They are
provided with four ports (transformed isolated).

They can be used for adapting Kroma analogue intercom equipments to the
digital matrix (such as Beltpacks BP6000, concentrators CE6000, user panels TP6000,
radio base stations, talent earpieces, etc).

User must assing matrix ports to the 4 different sources independently thru
Indico software.

Front leds of TA7000 indicate digital port status. Have in mind that they inform
only about digital, not analogue ports.

%,

TAZOOO

BCTY 3
ERROR
PORT O {7
PORT 1 {3
PORT2 O
PORT 3 {7

+8y ()
+2.av
+3.3 O

ARALCG
4 VWIRES

%,

Picture 3.69 Front TA7000.

4-wire signal level can be adjusted individually thru 4 potentiometers in the
board.

Front leds of TA7003 indicate digital port status. Have in mind that they inform
only about digital, not analogue ports.
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%,

TAFOO3

BCTY
ERROR O3
PORTO &3
PORT1 &3
PORT 2 (3
PORT 3 &3

+5v (O
28 O
133 O

AMALOG
2WIRES

%,

Picture 3.70 Front TA7003.

For both boards, the information shown is as follows:

ACTV = Green Led for checking the control side of the board. If flickering,
functioning is OK.

ERROR = Red Led for checking configuration errors when switching on the
system. If on, board becomes non-operative.

PORT 0 = Red Led for checking connection between digital port 0 to
matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist.

PORT 1 = Red Led for checking connection between digital port 1 to
matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist.

PORT 2 = Red Led for checking connection between digital port 2 to
matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist.

PORT 3 = Red Led for checking connection between digital port 3 to
matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist.

+5v = Green Led for +5v power supply for the control side of the board.

+2.5v = Green Led for +2.5v power supply for the comunication-to-matrix
side of the board.

+3.3v 2 Green Led for +3.3v power supply for the audio conversion side of
the board.
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If one of the three voltage leds fails, board becomes non-operative.

Form Indico config programme, user might adjust the level gain between -12dB
and +12dB, with 6dB steps. This procedure can be done with the input and output of
every port (useful for external sources which commonly carry different volume levels).

TECH SPECS:

Dimensions

Weight

Power

Signal format

Digital Connection
Analogue Connection

analogue /O

3RU/19”, 360 mm deep with mechanical
920g with rear

+20v, -20v external PS

Codec 44,1Khz sampling, 24bits audio
RJ45 in digital

SUBD9H in single rear,

SUBDG62H in double rear

max level 12dBv

bandwidth 100Hz-10kHz

SNR > 80 dB

THD < 0.15% at 4 dB
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3.7.2 INTERFACE FOR PSTN LINES TA7002

This board adapts PSTN signals (analogue telephone lines) to the digital
protocol of the intercom. It is provided with two digital ports (two FXO-type interfaces),
so two telephone lines can be connected.

User must indicate TA7002 board when assigning the matrix ports thru Indico
software. Also it must be declared: telephone numbers, call management...

For checking the status between the digital port of the board and the matrix,
there are two leds (one per each line):

%,

TAJOOZ

ACTY (O
ERROR (3
PHOME 0 (7
PHOME 1 ¢
PORT O &
PORT 1 (3

+a3y
+2av O
+33 O

TELEPHCRY

%,

Picture 3.71 Front TA7002.

The board is also provided with two aux analogue Input/output (one per
channel) for outputting & monitoring the telephone signal.

Front leds indicate the following:
- ACTV = Green Led for checking the control side of the board. If flickering,
functioning is OK.

- ERROR = Red Led for checking configuration errors when switching on the
system. If on, board becomes non-operative.

- PHONE 0 = Red led for checking the status of the connection of Phone

port 0 to the telephone network. When there’s a call, it remains on. When
the user hang s up, the led switches off.

Page 94 Digital Intercom



TB7000

- PHONE 1 = Red led for checking the status of the connection of Phone
Port 1 to the telephone network. When there’s a call, it remains on. When
the user hang s up, the led switches off.

- PORT 0 = Red Led for checking connection between digital port 0 to
matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist.

- PORT 1 = Red Led for checking connection between digital port 1 to
matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist.

- +5v =2 Green Led for +5v power supply for the control side of the board.

- +2.5v = Green Led for +2.5v power supply for the comunication-to-matrix
side of the board.

- +3.3v & Green Led for +3.3v power supply for the audio conversion side of
the board.

If one of the three voltage leds fails, board becomes non-operative.

TECH SPECS:
Dimensions 3RU/19”, 360 mm deep with mechanical
Weight 870g with rear
Power Supply +20v, -20v external PS
Signal format Codec 44,1Khz sampling, 24bits audio
Digital Conneciton RJ45 in digital
Analogue Connection SUBD9H in single rear,
SUBDG62H in double rear
Telephone Connection RJ11 Connectors
Bandwidth 150Hz-3kHz
Aux Analogue I/O Max level 12dBv
Bandwidth 150Hz-10kHz
SNR > 70 dB

THD < 3% at 4 dBv
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3.7.3 INTERFACE FOR TELEPHONE SET TA7004

It adapts the digital intercom protocol to a telephone set. With two digital ports
(two FXS-type interfaces), so two telephone sets can be converted into user intercom
panels. They can be use the dialling keypad as the keyboard of a panel (apart from a
normal dialling keypad to make/receive calls). Interface act as a local exchange of the
intercom system.

It can interface with DECT wireless terminals so users that carry them can be
located at all times.

User must indicate TA7002 board when assigning the matrix ports thru Indico
software. Also it must be declared: telephone number configuration, call management,
DTMF call selection...

For checking the status between the digital port of the board and the matrix,
there are two leds (one per each line):

TA7OD4

SCTY O
ERROR 3
PHOME O O
PHOME 1 (73
PORT 04
PORT 1 O

+oy
+25¢ (O
+33w (0

PHOME

%,

Picture 3.72 Front TA7004.

The board is also provided with two aux analogue Input/output (one per
channel) for outputting & monitoring the telephone signal.

Front leds indicate the following:
- ACTV = Green Led for checking the control side of the board. If flickering,
functioning is OK.

- ERROR = Red Led for checking configuration errors when switching on the
system. If on, board becomes non-operative.
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- PHONE 0 = Red led for checking the status of the connection of Phone
port 0 to the telephone network. When there’s a call, it remains on. When
the user hang s up, the led switches off.

- PHONE 1 = Red led for checking the status of the connection of Phone
Port 1 to the telephone network. When there’s a call, it remains on. When
the user hang s up, the led switches off.

- PORT 0 = Red Led for checking connection between digital port 0 to
matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist.

- PORT 1 = Red Led for checking connection between digital port 1 to
matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist.

- +5v =2 Green Led for +5v power supply for the control side of the board.

- +2.5v = Green Led for +2.5v power supply for the comunication-to-matrix
side of the board.

- +3.3v & Green Led for +3.3v power supply for the audio conversion side of
the board.

If one of the three voltage leds fails, board becomes non-operative.

For starting a call addressing a certain user panel, wait for the tone and enter
the destination port. Then press ' (asterisk) to activate the communication. For
hanging up, enter the port number whose call we want to stop and press ‘#. previously
to this, user must have configured the assignments and gone thru the call management
menus at Indico config programme.

TECH SPECS:
Dimensions 3RU/19”, 360 mm deep with mechanical
Weight 870g with rear
Power Supply +20v, -20v external PS
Signal Format Codec 44,1Khz sampling, 24bits audio
Digital Connection RJ45 in digital
Analogue Connection SUBD9H in single rear,
SUBDG62H in double rear
Telephone Connection RJ11 connectors
Bandwidth 150Hz-3kHz
Aux Analogue I/O Max level 12dBv
Bandwidth 150Hz-10kHz
SNR > 70 dB

THD < 3% at 4 dB
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3.7.4 INTERFACE FOR ISDN LINES (G.722 PRONTO2) TA7001

This interface is used for ISDN lines (G.722 and G.711 protocols). It remotely
controls Pronto2 Audiocodec (which establishes the communication with the ISDN
network). User will be able to manage this equipment from the user panel and also
manually from the keyboard of the equipment itself.

Each board is provided with four digital ports, so it can keep up to four different
communications (so it can handle up to two Pronto2 equipments: remember that each
physical ISDN line carries two B channels). Each ISDN line must be connected to its
Pronto2 equipment thru the RJ45 connector labelled as ‘ISDN S/T'.

Thru Indico config programme, user must assign each used port from the
TA7001 to the matrix, define the type of communication protocol (if it's G.722), ISDN
number, allowed incoming calls, call management to user panels, etc.

From the Pronto2 menu (LCD+ front keyboard), user must select “manual
response” for the incoming calls to be routed to the intercom.

Front leds indicate the following:

- ACTV = Green Led for checking the control side of the board. If flickering,
functioning is OK.

- ERROR = Red Led for checking configuration errors when switching on the
system. If on, board becomes non-operative.

- ISDN 0-1 = Red led for checking the status of the connection with ISDN
network/Pronto2. When there’s a call from any of the B channels, it remains
flickering.

- ISDN 2-3 = Red led for checking the status of the connection with ISDN
network/Pronto2. When there’s a call from any of the B channels, it remains
flickering.

- PORT 0-1 = Red Led for checking connection between digital port 0-1 to

matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist.

- PORT 2-3 2 Red Led for checking connection between digital port 2-3 to
matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist.

- +5v = Green Led for +5v power supply for the control side of the board.

- +2.5v = Green Led for +2.5v power supply for the comunication-to-matrix
side of the board.

- +3.3v 2 Green Led for +3.3v power supply for the audio conversion side of
the board.

If one of the three voltage leds fails, board becomes non-operative.
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TECH SPECS:

Dimensions

Weight

Power supply

Signal format

Digital Connection
Analogue Connection

Analogue I/O

2,

TAZOO

ACTY O
ERROR O
ISDM 0-1 O3
ISDM 2-5
PORT 0-1 (7
PORT 2-3 (73

+5y
+2.8v O
+3.3v O

ISDN G722

%,

Picture 3.73 Front TA7001.

2RU/19”, 360 mm deep with mechanical
920g with rear

+20v, -20v external PS

Codec 44,1Khz sampling, 24bits audio
RJ45 in digital

SUBDYH in single rear,

SUBDG62H in double rear

Max level 12dBv

Bandwidth 100Hz-10kHz

SNR > 80 dB

THD < 0.15% at 4 dB
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3.7.5 INTERFACE TO ISDN LINES (G.711) TD7000

They interface with ISDN lines thru G.711 protocol. They receive the audio
coming from the intercom system and integrate it with the ISDN line and also they
extract the audio (B channel) from the ISDN line and integrate into the intercom. At the
same time these boards adapt the audio to the digital protocol of the intercom.

Thru Indico config programme, user must assign each used port from the
TD7000 to the matrix, telephone number per port, allowed incoming calls, call
management to user panels, etc.

For checking the status between the digital port of the board and the matrix,
there are several leds:

D

TO/000

ACT. 3
ERROR
SN 0 £
IS0 1 ¢y

PORT 043
PORT 1 {2

+ay 3
+2.3v O
+33 O

IS0

%,

Picture 3.74 Front TD7000.

- ACTV = Green Led for checking the control side of the board. If flickering,
functioning is OK.

- ERROR = Red Led for checking configuration errors when switching on the
system. If on, board becomes non-operative.

- ISDN 0 = Red led for checking the status of the connection with ISDN
network. When there’s a call from any of the B channels, it remains
flickering.

- ISDN 1 = Red led for checking the status of the connection with ISDN

network. When there’s a call from any of the B channels, it remains
flickering.
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- PORT 0 = Red Led for checking connection between digital port 0 to
matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist. Note that it indicates digital communication, not analogue.

- PORT 1 = Red Led for checking connection between digital port 2-3 to
matrix. If flickering, functioning is OK. If on, communication with matrix does
not exist.

- +5v =2 Green Led for +5v power supply for the control side of the board.

- +2.5v = Green Led for +2.5v power supply for the comunication-to-matrix
side of the board.

- +3.3v 2 Green Led for +3.3v power supply for the audio conversion side of
the board.

If one of the three voltage leds fails, board becomes non-operative.

TECH SPECS:
Dimensions 3RU/19”, 360 mm deep with mechanical
Weight 620g with rear
Power supply +20v, -20v external PS
Signal format | Codec 44,1Khz sampling, 24bits audio
Digital Connection RJ45 in digital
Analogue Connection SUBD9H in single rear,
SUBDG62H in double rear
Analogue 1/0 Max level 12dBV
Bandwidth 100Hz-10kHz
SNR > 80 dB

THD < 0.1% at 4 dB
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3.7.6 GSM TD7001

It interfaces between the digital protocol of the matrix and the GSM network. It
works at 900Mhz and 1800Mhz frequencies (it’s dual band so the final frequency will
depend on the SIM card inserted).

MATRIX } { MATRIX
TD7001 TD7001

TMZ000 TM7000

TP7000 TR7000

i U<

ML TELEPHOMNY

Picture 3.75 GSM TD7001.

Any user will be able to contact with a mobile phone or a GSM interface of
another network (so one channel communication between matrixes can be established
thru GSM network).

Thru Indico config programme, user must assign each used port from the
TD7001 to the matrix, telephone number, allowed incoming calls, call management to
user panels, etc.

%,

TO7001

LCTY O
ERROR 3
G5 O
PORT {3

+5y ()
+2.a O
+33v O

G

%,

Picture 3.76 Front GSM TD7001.
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For checking the status between the digital port of the board and the matrix,

there are several leds:

ACTV = Green Led for checking the control side of the board. If flickering,
functioning is OK.

ERROR = Red Led for checking configuration errors when switching on the
system. If on, board becomes non-operative.

GSM = When the red led flickers, communication with GSM network has
been properly established.

PORT = When the red led flickers, communication with matrix has been
properly established.

+5v = Green Led for +5v power supply for the control side of the board.

+2.5v = Green Led for +2.5v power supply for the comunication-to-matrix
side of the board.

+3.3v = Green Led for +3.3v power supply for the audio conversion side of

the board.

If one of the three voltage leds fails, board becomes non-operative.

User must insert the SIM (smart card) thru the front slot so that the GSM
module inside starts working. Have in mind that it cannot request a PIN (security
number) to avoid accidental system blockings.

TECH SPECS:

Dimensions

Weight

Power supply

Siganl format

Digital Connection
Analogue Connection

Antenna
Analogue I/O

3RU/19”, 360 mm deep with mechanical
660g with rear

+20v, -20v external PS

Codec 44,1Khz sampling, 24bits audio
RJ45 in digital

SUBD9H in single rear,

SUBDG62H in double rear

External, thru rear BNC

Max level 12dBv

Bandwidth 100Hz-7kHz

SNR > 70 dB

THD < 0.3% at 4 dB
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3.8 AUTONOMOUS UNITS

These interfaces are not inserted as boards but rack-mounted. They integrate
Kroma digital intercom with external systems.

3.8.1 VoIP TI7011

This interface thru IP Protocol can work independently of the system connected
to it. For the communication, there must be two equipments: the local one (usually an
interface of the intercom matrix that send the data packages) and the remote one (in
charge of receiving them and synchronizing).

It is user transparent as it acts in “tunnel mode” between external systems and
allows a full duplex communication (audi with aux data) between source and
destination.

Depending on the system to interconnect, there are several ways of functioning:
a) Interface connected to TB7000 = The local interface is connected to the
digital intercom thru a matrix port (audio and data communication). With

Indico config programme, user will declare its matrix ports and assign panel
keys to the TI7011. See below:
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MATRIX TH7RHX

Rud5
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Ruld3

TIF011 REMOTE

TPI000

Picture 3.77 Interconnection with TB700 thru VOIP

b) Interface connected to TB6000 = Local interface is connected to the

analogue intercom thru a matrix port (audio and data communication). With

MAP config programme, user will declare its matrix ports and assign panel
keys to the TI7011. See below:
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Picture 3.78 Interconnection with TB600 thru VOIP

Interface connected to a generic system = Local

and

TIFO LOCAL

TIF011 REMOTE

remote

equipments are connected to any generic system. Configuration is done thru
serial RS232 (in future upgrades, config will be done thru the web browser

of the equipment/interface).
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Picture 3.79 Interconnection thru VOIP
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In the last case, use only the analogue port (SUBD9) for the input/output of IP
communication, apart from controlling the system thru RS232.

In the digital interconnection, “Analogue Port 0” becomes an aux analogue port,
which can be used for sending audio signals (in addition to the one coming from the
digital matrix).

For checking the status between the digital port of the board and the matrix,
there are several leds:

® FEthernet = 3 green leds on the rear panel indicate the status of:

® TX - Transmission to the Ethernet network.
® RX - Data reception from the network.
® (COL - Physical collusion of RX and TX.

OO0

Picture 3.80 Ethernet Leds.

® Power Supply = There are three front green leds that tell about board voltages
(+2.5v, +3.3v, +5v). There must be on.
+2.5%

+3.5v

+5Vﬁ
OO0

PFOWER
Picture 3.81 Power Leds.

® Control = Three front leds indicate the following:

LINK
ERROR

ﬂCT_I
000

ACTIVITY
Picture 3.82 Control Leds.
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® ACT-> Green led that shows that micro-controller is working properly (if
flickering).

® ERROR- Red led that shows some configuration error when switching on
the system (if on). Reboot if necesary.

® |INK > Green led that indicates Ethernet connection. If off, cable is
unplugged and interface non-operative.

® Data Communication = There are front leds that inform about the following:

FAIL TX
TCP

1
0000

TX /RX
Picture 3.83 Data Leds.

® FAIL RX-> Red led that tells about a failure at the received data. If
flickering, buffer is overload.

® FAIL_TX-> Red led that tells about a failure at the sent data. If flickering,
buffer is overload.

® TCP - Red led that tells about TCP. If flickering, data packages are being
sent properly with this protocol. If off, there’s saturation problem.

® UDP - Red led that tells about UDP. If flickering, audio packages with UDP
protocol are being properly received. If off during an established
communication, there are “silent” packages that shouldn’t be treated.

TECH SPECS:

Dimensions 1RU, 320 mm deep
Weight 4,7kg
Power Supply +12v, -12v, +5v external PS, redundant
Signal Format Codec 44,1Khz sampling, 24bits audio
Digital Connection RJ45 in digital intercom, CAT 5
Ethernet connection RJ45 with B=100Kb/s, minimum
Analogue Connection SUBD9H in rear panel
Analogue 1/O Max level 12dBv

Bandwidth 100Hz-7kHz

SNR > 70 dB

THD < 0.3% at 4 dB
Firmware Upgrade thru RS-232 and SUBD-9
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3.8.2 GPIO TALLYS GP7020
This is an interface for Kroma Digital Intercom TB7000 and Analogue TB6100,
with 20 optoisoated inputs for tallys and 20 relay outputs (by contact closure).

Input/Outputs can be configured as a panel thru Indico (TB7000) and MAP
(TB6000) config programmes, with different commands assigned as if they were keys.

Inputs are optoisolated and are activated by tension (from +5v to +48v). It offers
+15v in its tally input in case it must be used with an external equipment with a tally
output by contact closure (e.g. a video switcher). Ground of the own equipment is
applied.

Outputs are activated by internal contact closure, which can be selected from
the config programme. Thru front LCD user can see the active inputs and outputs.

Firmware upgrades are done thru RS232 (serial COM port of a PC). Power
supply is external (+15v) with redundancy available.

The equipment send commands to the panels when its inputs are activated.

See below the front panel:

L) -
H 0.3 4.7 &M 1215 16.19 AUX CAHCEL oK = POWER

1 O

8]
ouT 0.3 4.7 811 1215 1619 AUX ACT
- -

Picture 3.84 Front Panel GP7020.

User must declare the matrix port connected to the I/O Interface and assign
commands to inputs and outputs as if an user panel.

A front led tells about power supply. The LCD informs on matrix connection and
each of the 20 I/Os status.

Kroma Telecom GPT020

Hot connected

Picture 3.85 Main menu GP7020.

User has two keys to browse at the menu: OK, for entering the status menu
and CANCEL, for escaping to the main menu.

Press OK to know about I/Os status:
- Inputs > If shadowed, input has been activated by tension.

- Outputs - If shadowed, output is activated by contact closure.
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There’s a red led to inform about activation.

See below that inputs 0, 3, 9 & 13 and outputs 1,5,11 &14 are activated. Press
CANCEL to return to the main menu.

IHPUTS: BOON 0000 OO0 OmO0 0000

QUTPUTS: OmO0 OmO0 O00OR OOR0 0000

Picture 3.86 Status Menu I/O.

TECH SPECS:

Dimensions 1RU, 180 mm deep

Weight 2,250kg

Power Supply +15v external PS, redundant

Signal Format Codec 44,1Khz sampling, 24bits audio
Digital Connection RJ45 in digital intercom, CAT 5
Analogue Connection SUBD9H in rear, only data

Tally-IN Connection SUBD-62 female in rear

Tally-OUT Connection SUBD-62 male in rear

GPIO-Tallys 20 inputs and 20 outputs.

Optoisolated inputs with functioning tension between 5v and 48v. Electrical isolation of
230v DC max. Outpiuts by contact closure with isolation of 1000v DC.
Firmware Upgrade thru RS-232 and SUBD-25
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4 CONFIG SOFTWARE

Indico is the programme for creating and editing crosspoint maps. User
declares which equipments (matrix, panels, interfaces) are using which ports and
assigns commands to the different crosspoints.

This config programme is provided with Kroma intercom free of charge. It’s
Windows-run.

41 SET UP

Insert the CD-ROM, go to W\TB7000\Software\Setup.exe and double-click on the
icon.

«J Instalar - Indico Software o ] |

Bienvenido a la instalacion de
Indico Software.

Ezte programa instalar Indico 3.0 en su sistema.

Se recomienda que cierre todas las demas aplicaciones antes
de continuar.

Haga clic en Siguiente para continuar, Cancelar para zalir.

Cancelar |

Piture 4.1 Set up menu.

Press ‘siguiente’ (next) and choose the directory to save the programme. By
default, it’ll be saved at ‘Archivos de Programa’ (program files) of Windows.
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15 Setup - Indico Software

Select Destination Directory
Where should Indico Software be installed?

Select the falder where you would like Indico Software to be installed, then click Mest.

| EAKoma T elecomiindico

3 E:N
& Froma Telecom

[ Generadar Codigos
53 Indico

I=) MapB000
I MAPET0D
|53 Termninal
|53 Test Matriz

| “g® B pIogramas b

The program reguires at leazt 3.5 MB of dizk zpace.

¢ Back ” Mest = ]l Cancel ]

Picture 4.2 Selecting the Directory.

Next step is to select the program menu for the software to appear. By default,

the name chosen is ‘kroma Telecom’ (group of programmes).

flo Setup - Indico Software

Select Start Menu Folder
Where should Setup place the program's shortouts?

Select the Start benu falder in which pau wauld like Setup to create the program's
shortouts, then click Mext.

| k.roma T elecormlndico

Ancesarios ol
Altera ol
AutaCAD B14.0 - Ezpatiol

Corel Graphics Suite 11

Deszsinstalar AutoCAD B14.0 - Espaifiol

Ghoztgum

Herramientas administrativaz =

Hernamientas de Microsoft Office

Intel Application Accelerator

Juegoz

k.roma Telecom

Logitech P

MATI AR B M

[ < Back ” Mest > l[ Cancel

Picture 4.3 Group of programmes name.
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Press Next so as to have the option of creating a desktop icon. It's advised for
quicker access to Indico.

it Setup - Indico Software

Select Additional Tasks "
Which additional tazks should be performed’? )

Select the additional tazks you would like Setup to perfarm while ingtalling [ndico
Software, then click Mest.

Additional icons:

Create a desktop icon

¢ Back ” Mewt = J[ Cancel ]

Picture 4.4 Group of programs name

Press ‘Next’ and it’ll appear a set up summary and a request for beginning to
install.

T Setup - Indico Software

Ready to Install ~
Setup iz now ready ta begin installing [ndico Software on paur compter.

Click. Install to continue with the installation, or click Back if you want to review or
change any settings.

Deztination directony:
E:Aroma Telecomtindico

Start tenu folder:
Froma Telecomindico

| additional tazks:
Create a desktop icon

[ < Back ” Inztall l[ Cancel

Picture 4.5 Set up summary
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Once the files have been copied, set up is finished. So we might begin to use
the programme.

flat Setup - Indico Software E||§|E|

Completing the Indico Software
Setup Wizard

Setup has finished instaling Indica Software on vour compter.
_The application may be launched by zelecting the instaled
Icong.

Click Finizh to exit Setup.

Ejecutar Indica Software

Picture 4.6 Successfully installed
Desktop icon opens ‘Indico.exe’. New version deletes old Indico versions.

If an online communication is needed, connect a computer to the Master unit
thru a serial RS232 cable (see chapter 2.1).

4.2 MENU OPTIONS

Double-click on the desktop icon or on Indico.exe at the chosen directory to
have access to the main menu. Enter the password (KROMA in capital letters by
default), which is possible to be changed or not requested.
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! Indico Software

File Edit ©Online view ‘Window Help
IEEEIENEL
J: Guick Pragramming e T ok iy |

- & €

= KR XA e

Operator Pazsword

Picture 4.7 Entering password
Tree-menus, direct-access icons and map information will appear as follows:

- File Menu =» for creating new maps, saving and opening them, printing
configurations and labels, emailing maps or selecting a new password:

%* Indico Software - [TEST_TW.XPT]
@ FIEW Edit Online Miew Wwindow  Help

LE Mew... Chrl+h
Qper... Chrl+0
JD Close W Oy ‘

{2 Save Chrl+5 2l ¢|
o Saveds.. TI
— | Port 000 [TPZ100]-7100
Print... Chrl+P
Print Labels I

Prink Prewview

Prink Setup,..
Options. ..

Send. ..

1 TEST_TW. xPT

Exit
T T PUTIRER
{[E} Po11-BP1

{[E} Po12-BP2
{[8} PO13-EF3
@ Po14-RDS1

Picture 4.8 File menu
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- New -> for creating new crosspoint maps.
- Open -> for opening a *.xpt file (an existing map).

- Close -> for closing the active map.

- Save -> for saving the active map (with the already chosen name).

- Save As -> for saving the active map (with a different name).

- Print -> for printing the active map in text format.

- Print Labels -> for printing labels of chosen panels for being cut and

posted at the transparent keys.

- Print Preview -> for having a previous image of the active map to be

printed.

- Print Setup -> for setting up the printing values.

- Options -> for selecting options such as setting up the COM port of the

computer or modifying security access.
- Send -> for emailing the active map.

- Exit -> for exiting config software.

For modifying access password, choose ‘Options’ and click on ‘Change
Password’ label. Enter active password, new password and confirm. Then Accept.

Comunication D:unfig. Change Pazsword i

Actual Password

Mew Pazsword
Confirm Passwaord

Aceptar ] [Eancelar] [ Aplicar ] [ Ayuda

Figure 4.9 Access password Modification
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NOTE: If user wants no password at all, enter active password and leave others blank.

- Edit Menu =» for editing new ports, groups, telephone numbers, IFBs,
parameters and crosspoint audio levels. It also allows to copy configuration between
similar panels or activate quick programming option.

%* Indico Software - [TEST_TW.XPT]
E File M8 OnLine Miew Wwindow Help

Unda ChrlH+2

[]Ouick  Mew Port,..
= {m: e G.rcnup... : o
- . MNew Dial...
2 E ewre..

rt 000 [TF7100] - 7100

Remowve
Properties, ..

Audio Levels. ..
Copy Configuration, ..
Quick Pragrararming

&= PO0E-7016
fEH POO7-7010
8, PO0a-7210
= POOS-PODS
{[E} Po10-BRO
{[E} Po11-BP1
{[8} Po12-EF2
{[E} Po13-6P3

Figure 4.10 Edit Menu

Options are as follows:

- Undo -> for going backwards in the last actions introduced.

- New Port -> for assigning new ports.

- New Group -> for creating port groups.

- New Dial -> for entering new telephone numbers.

- New IFB (Interrupt FoldBack) -> for creating new IFBS. It creates a
new crosspoint that can be interrupted (foe example, orders from
director to talent).

- Remove -> for deleting ports of the XPT map.

- Properties -> for editing the port parameters of the left window.

- Audio Levels -> for editing audio level of crosspoints (from source to
target).

- Copy Configuration -> for copying the configuration of a panel keys into
a similar terminal (so as to avoid delaying in system set up).
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Quick Programming -> for creating crosspoint maps in a faster way.

- Online Menu =» for conecting with Master unit of Intercom for editing maps,
activating crosspoints, etc. Options are as follows:

O o &
[] Quick Progr
=

#* Indico Software - [TEST_TW_XPT]
|8 File Edit BERRETS view window Help

Conneck bo Makrix

Open Map in Masker.., 7 e ———
Save Map to Master. ., - L

|
Ackivate Map, .. 'f|

Delete Map. .. D00 [TP7100] - 7100
Swskem Status...

Crosspaoints. ..
Drate/Time Synchronization

B PO03-i55M

B FPo04-TELF
B POOS-PHCHN
&= PO0S-7016
(B8 POO7-7010
BB, PO0S-7210
MEE POOS-PODS
{[E} Po10-BPO

(|8} PO11-EP1

{[E} Po12-BP2

L = T

Figure 4.11 Online Menu

Connect to Matrix -> for connecting to the Master. Do this first before
considering other options.

Open Map in Master -> for loading a map from Master to Computer.
Choose among the eight available to modify its parameters.

Save Map to Master -> for saving a map from Computer to Master in
one of the eight available banks.

Activate Map -> for activating one of the eight maps of the Master unit.
Delete Map -> for deleting one of the eight maps of the Master unit.
System Status -> for status checking of active map.

Crosspoint -> for monitoring, activating and de-activating crossopints. It
has priority over panel keys.

Date/Time Synchronization -> fod time synchronizing between Master
and Computer.
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- View Menu = for viewing the different tool bars.

%* Indico Software - [TEST_TW.XPT]
|8 File Edit Online

YWiswm

Window  Help

| O Bﬂ'n % T|:u:|||.3r
[ | w Status B )
|:| Guick Prograrmming . X Sp;tus S - |_ |
SARMKEB XH VTE & &
| = TM7128 =]
= EF rorts — | Port 000 [TPZ100]-7100

| L==1 POOO0-7100
' EEE PO01-TOND
Em Fo0z-RDSI
B PO03-55M
B POO4-TELF
EE POOS-PHOM
&= PO0E-7016
B8l POO7-7010
=, PO0E-7210
B8 PO09-PO0S
{[E} Po10-BRO
{[E) Po11-6r1
{E) ro1z-gr2
{[E} Po13-BP3
I PO14-RDS1

Figure 4.12 Toolbar menu

- Window Menu = for viewing the map in a different window configuration or
generating a map in a new window. See below:

%* Indico Software - [TEST_TW.XPT: 2]
|8 File Edit Online view RO

DEH & 2K
|:| Guick Programming =
KB Xg |

Cascade
Tile
Arrange Icons

-1

1= I 1= I | |

1 TEST_TW.xPT:1

3 ports v 2 TEST_TW.%PT:2
—+ IFB =

F=R Dial
. Groups

[+

Figure 4.13 User window menu
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- Help Menu =» for advising the user on the system commands.

%* Indico Software - [TEST_TW.XPT]
E File Edit ©OnLine Yiew Wwindow BEE[E

DEHE & 27N

[]Ouick Programming ~ ses [ (1 About Indico Software... = o0 | |
SANE XE Bl <
| = TM7128 ~
' g B rorts ~ | Portooo [TP7100] - 7100

=1 POOO-7100
BB POO1-TOMD
Em Fo0Z-RDST
EE| PO03-GSM
B PO04-TELF
Em PO0S-PHOR
= PO0S-7016
Rl POO7-7010
£, PO0E-7210
[ PO09-PODY
{8} poio-ERO
(@} po11-Br1
([} Po12-BR2
(B} Poi3-ER3
Em Po14-RDS1

Figure 4.14 Help menu

There are also isons to have quick access to certain commands of the main
menu: A toolbar keeps the map filing commands (open, save...). See below:

DEEd & 2%

iy 3 & 0 @S H

1. CREAR MUEWO MAPA,

2. ABRIR MAPS ALAMACERNADC
3. GUARDAR MAPA ACTLAL

4. IMPRIMIF MAPA ACTUAL

5. VERSION DE SOFTWARE

6. AYLDA GUIADA

Figure 4.15 File Icons
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1 AMADIR UM NUEVQO PANEL O TARIETA [/0
2 AMADIR UM NMUEVO GRUPQO DE USUARIOS
3 AFIADIR UM MUEVO IFB

1 AMADIR UM MUEVC MUMERO TELEFOMICO
5 ELIMIMAR BECURSOS SELECCIOMADROS

6 EDITAR RECURZO SELECCTONATD

F COPNIAR. COMFICURACION ENTRE MAMELES
8 EDITAR MIVELESDS DE ALTIO

@ TRAER MADNMA DEIDE MASTER
10 SATLVAR NMaTA & NMASTER
11 COMECTAR COM MASTER.

Figure 4.16 Map Icons

The last toolbar keeps the programming commands for key assignments
(command, source, target). See below:

%* Indico Software - [TEST_TW_XPT]

E File Edit Online Yiew Window Help
DEd & 2% |
[uick Pragrarmming I# Talk Orily v =h
e ] ﬂ. )-( g = Tak & Listen

A | zten Only PF100] - 7100
=E* Remate One Way
‘:’ Remote Bath 'ways
S!.-. Hemaote Vaolume

B8 PO04-TELF
B POOS-PHOMN
d= PO06-7016
fE8 PO07-7010
=, poDz-7210
fE& PO09-PO0S
{[E} Po10-BPO

FEIY mma s s

(7100

Figure 4.17 Quick programming

Quick programming is done only at the chosen panel. If quick programming is
required for a second panel, de-activate this option, choose the panel and activate it

again.
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4.3 TERMINAL TYPES
Once a map is opened, each matrix port must be assigned to a type of
panel/interface.

At the left window it appears the map with its ports and terminals assigned. An
extended description appears at the right window.

Parameters that appear are port number, nemotecnic and type of terminal.

%* Indico Software - [TEST_TW.XPT]
E File Edit ©OnLine Yiew Wwindow Help

DEHE & 27N

LILIICK Frogramrming # ! I L= m -
BAMEB XE e T I
E TM7125 # | Port MName Type L

= o F'-:_-rt:'- Edn 7100 TR7100
=4 Po00-7100 03 TOMO B TA7000/TATO03
B POO1-TONO - RDSI EE TO7000/TATO0L
o o || W i =
@ Po04-TELF i 4 Lz . TA7007
B FOOS-PHON i 5 e e I
&= PO0s-7016 K i =X
{ER POO7-7010 0 L3 e P
B, PO0a-7210 i = et BB, T72lo
{ER PO0S-PODS s POO3 (B TP7010
(B} Po10-BrD 10 BP0 \B) 7o
(B} Po11-6R1 e BR1 (Bl Twrooo

Figure 4.18 Assigned ports

For a new terminal to be assigned to a matrix port, go to ‘Edit->New Port’ or
click on the following icon:

a—

|

For deleting a terminal, go to ‘Edit->Remove’ or click on the following icon:
>

We must differentiate two types of terminals:
- User panels (rack, desktop, wireless beltpacks...).

- I/O Interfaces (boards for the rack frame TR7000 or rack units).
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4.3.1 PANELS

See below the different panels to be assigne to matrix ports:

MNew Terminal

TP7016 Hosi Pot
Po23 (29 v|
Drezcription
TP7100
1/0 Ports ok | | Cancel

Figure 4.19 Assigning a new terminal

Figure 4.22 TP7100 (8 keys and 10 pages), graphic LCD and dialling keypad
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9009999 -
L 00000000

o
’ e

e €~ CEER

e

T I e L

Figure 4.23 TP7210 (desktop, 16 keys, pages, LCD, dialling keypad)

Figure 4.24 wireless beltpack TW7000 (4-key panel)

Each panel assigned to the matrix must receive its port number and a 4-
character identifying label that will be used for key programming later on. There is an
extended description option available.

For assigning commands to the different keys, choose the proper panel at the
left window. At the right window, double-click on the key to be programmed, choose the
command, target (if needed) and press ‘Add’. Activate it and key has been configured.
A label is generated as well. For more info, check 4.4.4.

4.3.2 1/0 INTERFACES

Firstly interfaces must be assigned to matrix ports with Indico config
programme. Choose among the available by clicking on “//O Ports”. See below:
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X

Mew Terminal

Terminalz
1/0 Ports
~
Mame Part
PO29 |29 v|
[Drescription
oo w OF ] [ Cancel ]

Figure 4.25 A new /O Interface is assigned to a matrix port
Choose the availble interface and assign the used ports of them to the matrix

ports. Each one is independent from the rest of the same board. Enter a 4-character
mnemotecnic.

Then choose among the different I/O Interfaces:

® TA7000/TA7003 - 4-port Interface. Each of the digital ports must be assigned to
the matrix ports independently.

i Indico Software - [TEST_TW.XPT]
E File Edit Online WYew Window Help

DEH & 28

[Juick Frc (a] T 5l . |
SN X B4 5%
=l TM7126 ~

= Eg Ports

PO00-7100 Port 001 [TA7000/TATO03] - TONOD

Em FO0Z-RDSI Sudio Levels
B PO03-GSM : ;
Analogic Input Analogic Gukput
B PO04-TELF i _g 8
Em FO0S-PHON 0de v| ‘ 0de v
d=h PO06-7016
[E® PO07-7010

Figure 4.26 Audio Levels TA7000/TA7003
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They convert from 4-wire and 2-wire analogue into digital audio. Input/Output
audio levels can change from -12dB and +12dB in 6dB steps. This audio level works
locally on the port, so it’s independent from the crosspoint audio level.

® TD7000/TA7001 > 2-port Interface for ISDN lines (G.711 protocol) and 4-port
Interface for ISDN lines (G.722 protocol, to be connected to Audiocodec)
respectively. Each used B channel (audio) must have assigned a port a the active
map. Both interfaces are configured in the same way.

User must allow incoming calls into the system. For this, click on ‘Answer Incoming
Calls’, with two options:

- Allow all calls = Any incoming calls is routed to the destination panel
selected by the user. Chosee ‘any’, the destination panel at ‘Route to’ and Ok
with ‘Add’.

Incaming Calls:
[ Anzweer Incoming Cals

[¥] Pick up and roule audic
[#] Firsh bo amzwer

Incaning Call Rowting

Name Hurrber Ricute ta:
E & ] (o ]
Mame Mumbe Floute ba
any 7010

Figure 4.27 ISDN routing

Destination panel can be one or several, so any of them can answer.
Communication will end when all had hung up (release the active crosspoint
keys assigned to this communication). If one panel has this channel open,
communication will be kept open.

- Number selection @ Choose the nemotecnic from the number agenda
that’ll be allowed, destination panel at ‘Route to’ and vaidate with ‘Add’.

Page 127 Digital Intercom



TB7000

Incoeming Cals:
[#] #rzwsar Incoming Calz

Fick up ard route audia

First ko ariswest
Irzorring Cal Fowting
Mame Mumbsar Ricwta ta:
ang w = 7o
Harre Murnbes Fioule la
ROBE EB5BET FRE oo
HESA 125 0

Figure 4.28 ISDN number selection routing

bl Fiemone

Up to 128 telephone numbers can be entered thru the destination ports.
Any panel can enter a communication no matter if it was the one that started it

with the incoming call.

It's advised to assign the ISDN number to the physical line, because
when it is provided with more than one number, the interface will interact with

any of them.

DTMF menu is not available yet, foreseen for future upgrades.

® TD7001 > One-port interface for GSM lines. It works at 900Mhz and 1800Mhz

(according to the SIM card inserted).

User must allow incoming calls into the system. For this, click on ‘Answer

Incoming Calls’, with two options:

- Allow all calls = Any incoming calls is routed to the destination panel
selected by the user. Chosee ‘any’, the destination panel at ‘Route to’ and Ok

with ‘Add’.

Incaming Calls:
|| Anzwer Incoming Cals

[¥] Pick up and roule audic
[#] Firsh b anzwer

Incaning Call Rowting

Name Hurrber Ricute ta:
ay v = 100
.Name Mumbe: Fous to
any 010

Figure 4.29 GSM routing
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Destination panel can be one or several, so any of them can answer.
Communication will end when all had hung up (release the active crosspoint
keys assigned to this communication). If one panel has this channel open,
communication will be kept open.

- Number selection @ Choose the nemotecnic from the number agenda
that’ll be allowed, destination panel at ‘Route to’ and vaidate with ‘Add’.

Incorming Cals:
[#] s Incoming Calz

[+] Fick ug ard raute audia

First ko arswest
Irsc:oming Cal Routing
Mame Mumbsar Ricwta ta:
w v CEIE
H e Huenbes Fiout la
ROBE E8hEET FBE g
MESA 125 210

Figure 4.30 GSM number routing

Up to 128 telephone numbers can be entered thru the destination ports.
Any panel can enter a communication no matter if it was the one that started it
with the incoming call.

DTMF menu is not available yet, foreseen for future upgrades.

TA7002 > 2-port interface for PSTN lines. User must allow incoming calls into the
system. For this, click on ‘Answer Incoming Calls’. All calls are routed to the
destination panels. There is no option available for selecting numbers as some
exchanges do not send caller number. So choose ‘any’, target panel at ‘Route to’
and activate with ‘Add’.
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Incaming Calls:
[#] Anzwer Incoming Cals

[¥] Pick up and roule audic
[] First t anzwer

Incoming Call Rowting

Marme Mumber Ficiube to:
Ea & 0¥ (e |
MName Mumbe Raus ba
any g

Figure 4.31 PSTN routing

Destination panel can be one or several, so any of them can answer.
Communication will end when all had hung up (release the active crosspoint
keys assigned to this communication). If one panel has this channel open,
communication will be kept open.

This interface allows DTFM so user can create dynamic crosspoints

from the calling telephone set to other panels (different from the one that started
the communication).

Part 004 [TATOOZ] - TELF

DTHMF

DTHF | Actian A
] Tak 7210

1 TalkiListen RDS1ILAN]
z TalkiListen 7010

3

4

5

6

? W

Figure 4.32 DTMF assignments to crosspoints

That way a telephone set becomes a remote panel just by using the
dialling keypad and once the communication has been established.

For DTMF programming, double-click on the white column labeled as
“Action”. There are 128 DTMF available. After that, command and target
menus appear. For activating it, use ‘Add’. For exiting, ‘Close’.

During the communication, telephone user will dial the preprogrammed
DTMF sequence and then “*” (asterisk) for creating the crosspoint with another
panel. For ending that XPT, press the same sequence and then ‘# (hash
marks).

Example: See Picture 4.32 where it appears three programmed digits ‘0’,
‘1" and ‘2. If a communication thru ISDN line has been established, the
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telephone user might also speak to TP7210 panel just by pressing ‘0. If she
presses ‘2¥ could talk&listen with TP7010 panel, so keeping multiple
conversations with several panels, acting as if a remote. User can end each
communication pressing the DTMF and “#” (‘O# and ‘2#’) or simply hanging up.

® TA7004 - Interface for two telephone sets.
This interface allows the user to have a telephone set as if a user panel.

(so it gets integrated into the intercom system). DTFM can be programmed to
establish crosspoints.

Part 005 [TAFO04] - FHOM

DTMF
DTMF  Action Es Set
0 TalkéListen 7100
1 TalkéListen 7010
5 TakéListen 7016
5 TalkédListen 7210
4
5
5
7 L

Picture 4.33 DTMF assignments

For DTMF programming, double-click on the white column labeled as
“Action”. There are 128 DTMF available. After that, command and target
menus appear. For activating it, use ‘Add’. For exiting, ‘Close’.

When user hears tone, she must press the DTMF and “*’ (asterisk) to
create a crosspoint with a panle. For de-activating it, enter the DTMF sequence
and ‘#.

Other panels can assign keys to that telephone set, which will normally
ring and the user will be able to establish the communication.

Example: Picture 4.33 shows four DTMF digits (‘0’, ‘1’ ,'2’ and ‘3’). If
telephone set user presses ‘0*" she could speak to the TP7100 user. If pressed
‘2¥,  communication will be established with TP7016 panel. Multiple
communications can be established at the same time with different panels.

Any of the established conversations can be ended just by pressing
DTMF and ‘# (‘0# and 2#’) or just by hanging up.

® TI7011 - One-port interface via IP. The terminal to be programmed is the remote
panel that is connected to the interface, not the interface itself.
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LOCAL MATRIX
PAREL TPTO10

) D Gt ) ED )

REMCTE
|NTIE'2|E§$E I IMTERFACE IP

Picture 4.34 IP Interface Assignment

The picture above shows a TP7010 panel integrated remotely into an intercom
system thru IP Interface. So port 4 of matrix must be assigned to TP7010 (remote
panel) even though there is no phisical direct connection. That way user sees
transparently the panels connection, no matter the interface used (local, remote).

If two matrixes need to be interconnected thru IP, one port per matrix must be
assigned to this single communication channel. This port must be declared thru Indico
like a TA7000 at each end so an audio&data communication can be established with
remote signalling at each end.

® GP7020 > 20 GPIO Tally Interface, which can be configured like keys (as if it was
a panel).

The assignment of commands to the inputs is done as I/O were keys.
User must choose Input to configure, then double-click to assign a command
and a target. Validate by pressing ‘Add’ and then ‘Close’ to exit. When the input
is activated, the command will be executed.

Outputs are also configured as keys. Have in mind that the same key
must be assigned at the source panel and the target panel (because control
signalling is used so when the key is pressed at the origin panel, the GP7020
Interface will receive the origin of the communication and will close the output
relay (contact closure activation).

4.4 MAP CONFIG

For creating a new map, go to ‘File->New’ or click on the following icon:
O
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add a brief comment on this map.

=

|

Open...

Chrl+C
Close
Save Chrl+3
Save As,..,
Prirt. .. Zkrl+P
Print Labels

Prink Preview

Prink Setup. ..
Options. ..

Send...

—_—

Port 007 [TP7010] - 7010

Picture 4.35 New configuration map

Default map is for a 32-port matrix. Select a different one at ‘Edit->Properties’ or
click on Properties icon.

Ded & 2w

Type

POO0-7100
EEE POO1-TOMO
[ PO0Z-ROSI
EEEl POO3-G5M

EEE PO04-TELF

Em POOS-PHOM
== PO0s-7016
fER FO07-7010
BB, PO05-7210
fEH FO0S-PO0Y

[ | Buick Programming mp T2k Oply

BANKE X& &4 T2«

| = TM7128 || Matrix Type
= EE Ports B4 mriza

T 7024
TH7032
TH70E4
TH 7036

|

[ |

Dezcription

]

Picture 4.36 Matrix values

Select the proper matrix: TM7016 for 16x16 crosspoints, TM7024 for 24x24
crosspoints, TM7032 for 32x32 crosspoints, TM7064 for 64x64 crosspoints, TM7096
for 96x96 crosspoints and TM7128 for 128x128 crosspoints. At “Description”, user may

Once created, user must assign terminals to the different ports. For this, go to
‘Edit->New Port or click on the following menu:
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Note that terminals assigned must match the ones physically connected to the
matrix ports.

4.4.1 GROUPS

Indico programme allows the user to put several together so one source panel
can communicate to different users at the same time just by pressing one key or even
modify its audio level. For this, first create a group and then define its components.

For creating a new group, go to ‘Edit->New Group’ and name the group or press
the followin icon:
il

i | Indico Software - [Map1]
E File M Online Yiew ‘Window Help
O = Undo Chrl+2

Mew Port. ..

= Mlew Group, .. = |
| Mew Dial... = .t.
=5 Pew IFB... i Type Description

TM7052

Remove
Properties,..

Audio Levels., ..
Copy Configuration, ..

Picture 4.37 New group of users

Then assign the different matrix ports to the group by selecting the group name
and going to “Edit->Properties’.

Edit Group E|

Gioup Mame
CaMS

Fuvailable Ports: Poats in Group

] ~
7k PO
BP1

B8Pz Add >
)

GSM

PO0g

FOE

k]
PO20
POO? <- Remave
PO2Z

PO24
|pms e

Claze

Picture 4.38 Members of a group
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The picture above shows the group name, the available portsand the chosen
ones in two different columns. For adding a new one, select one of the available ports
at the left column and press ‘Add’. For removing a port out of a group, click on the
chosen port at the right column and press ‘Remove’. For exiting, press ‘Close’.

When one user presses the key for that group, all the members of the group will
listen to the source signal (like a ‘party line’). Groups are useful when we need to talk
with many people at the same time just by pressing one key.

442 IFB’s

IFB’s (Interrupted Foldback) are crosspoint that is interrupted by a thrid party,
with the possibility of audi olevel variations. Two opotions:

Direct IFB’s = When the signals from several sources to one destination can

be interrupted by a different source to the same destination. When this interrupting
input ends, the configured crosspoints to the destination are restablished.

-#- DIRECT FE's

o >__|_+_|H‘<, W CROSSPOINT O o >——|——|——|ﬂ‘%
o __|__ -- CROSSPONTOFF |__|__
5 | ‘ 5
= A O S = - ——|——|—|—

ey R RN

L T = IF IM3 CALL TO QLT o1t iz2 3
QUTPUTS QUTPUTS

Picture 4.39 Direct IFB

Picture above shows several direct IFB’s between several inputs and one
output. At left side, Output1 listens to Inputs 0 and 2. When Input3 wants to talk to
Output1, Inputs 0 and 2 are temporarily interrupted (see picture above, right side). In
this last case, output1 only listens to input3. When communication with Input3 ends,
situation goes back to usual status (left side of the picture above), where Outputi
listens to Input0 and 2.

Inverse IFB’s = When the signals from one source to several destinations can
be interrupted by the reply of one of the destinations. In this case, the replying answers
of these destinations are cut. When this interrupting communication ends, the
configured crosspoints to the destinations are restablished.
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-#- [NVERSE FB's
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Picture 4.40 Inverse IFB

se comprueba como en el estado normal de funcionamiento, la salidas 0, 2 y 3
escuchan a la entrada 1 (figura izquierda), ya que tienen asignado un IFB inverso.
Pero cuando la entrada 2 quiere hablar con la salida 1 (se fuerza por ejemplo una
llamada), las salidas 0 y 3 se interrumpen temporalmente (figura derecha),
escuchando Unicamente a la entrada 1 la salida 2, hasta que la comunicacion con la
entrada 2 finaliza y se vuelve al estado de reposo inicial (figura izquierda), donde las
salidas vuelven a escuchar a la entrada 1.

Picture above shows several inverse IFB’s between one input and several
outputs. At left side,

Output1 listens to Inputs 0 and 2. When Input3 wants to talk to Outputi, Inputs
0 and 2 are temporarily interrupted (see picture above, right side). In this last case,
output1 only listens to input3. When communication with Input3 ends, situation goes
back to usual status (left side of the picture above), where Output1 listens to Input0 and
2.

A new IFB can be added by ‘Edit->New IFB’ or clicking on the following icon:

#* Indico Software - [TEST_TW.XPT]
E File B8 Online View ‘Window Help
[ = Undo Chrl+2

Mews Part,.,
Mew Group... b

Mews Dial.., <+
MNew IFE. .. tix Type Description
TM7125

Remove
Properties., ..

Audio Levels, .,
Zopy Configuration. ..

[fER] PO07-7010

Picture 4.41 New IFB

Select Source and target at the IFB window that will appear.
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Picture 4.42 IFB assignment

User can choose between Direct IFB or Inverse IFB. Only with “Fix” or “Clear”,
these options are not available as these types of crosspoints are, respectively,
unchangeable or cannot be created. Types of IFBs are:

Fix = Fixed crosspoints that cannot be interrupted.

Cut = Crosspoints that can be interrupted by a thrid party. These direct IFBs are
also known as ‘standby’, as Inputs are temporarily cut towards an output.
Inverse IFB’s are usually called ‘inverse standby’, as outputs are temporarily cut
towards one input.

Dimmed Cut = As before except for there is no cut but its volume lowered. User
can choose the dB level.

Clear = Banned crosspoints. Source and target cannot establish communication.

For deleting an IFB, select this option at the left column, then choose the IFRB
to be deleted and go to ‘Edit->Remove’ o just click on the following icon:

b

4.4.3 DIALLING

Telephone numbers can be assigned to labels to as to integrate them in the
intercom system and send/receive phone calls. It's an agenda/directory that will be
used when assigning the different commands to the keys. A new number can be added
at ‘Edit->New Dial’ or clicking on the following icon:
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#* Indico Software - [TEST_TW.XPT]
E File B8 Online View ‘Window Help
[} & Undo Ctri+z

Mew Park, ..

- .. MewGroup...
i i R =

Mew Dial,..

= Mew IFE... tix Type Description

TM71258
Remove

Properties. ..

Audio Levels, .,
Zopy Configuration, ..

B8l FO07-7010

BB, PO05-7210
= raen REan

Picture 4.43 Creating a new telephone number

At the window that appears, enter the number, a label (identifying name) and
the communication protocol that will be used.

New Dial Entry

I arne Mumnber Cadec

JusN | 915292927 | [ Telefonia/G711 v
[ ] ] [ Cancel |]G?22

Picture 4.44 Creating a new telephone number

See below the different protocols used depending on the telecommunication
channel:

G.711 G.722
PSTN Yes NO
GSM Yes NO
ISDN Yes Yes

Chart 4.1 Codec Selection
By default use G.711. Only when a G.722 ISDN connection is needed, change
to that protocol.
4.4.4 KEYS
Once matrix ports have been assigned to the different types of terminals

(panels, interfaces), user must configure which command will be assigned to each
panel key. This procedure can be done in two ways:
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Noraml way = Double-click on the key to programme and fill the window.
Parameters and audio levels can be also chosen.

Quick way = From the main window, user can assign commands to keys. It’s the
best option if no special parameters are being entered.

See below the normal way of configuring the panels: Choose the panel to
configure by clicking on it at the left window. At the right side of the screen its front
picture will appear.

i Indice Software - [TEST_TW.XPT]
[ Fle Edt OnLine View Window Help

DEE & W
1 Quick Programming =

AEB XE B
= B3 Paorts
il Pooo-7Lo00
[ POOL-TOND
[ Po0Z-ROST
B POOZ-GSM 3
[ POO4-TELF -
[EE| POOS-PHOM
rr' AL

&

= S

Cal

Port D07 [TRPT010]- 7010

POATER .

AAIN
= pO0s-7016

4 11| POO7-7010
™ pooE-7zI0

FERl POOS-POOR
(@} Poio-Er0
(@} Poi11-EF1
{H) Po1z-EP2
(B} Po1zEF3
[ Po14-ROSE

mm rnas nees

ALITE
L

PAGO | PAGT | PAGZ | PAGE |

Picture 4.45 Panel selection

Double-click on the key to be programmed. See below the options:

Terminal: 7010 - Key: 015

Flavs Command
Command

~£* Aemote Dne wWay

o

= Tk Only

| jctar Orly

=t* Romote One Wy
F Ramcte Both \Wavs
<fa Ramote Volume
T Didl Cal

BT Volure »

A8 volums -

) Mic/Hezdohane
B rFrOG

PAEE

Labed
o 7oi0 v | | B GSM | .
=15
Cioszpoint
Taiget Irfoemation

Anadio Levels

Kep Function
[ Homal
(Latch 1
i |

Picture 4.46 Command assignment to keys
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Command = Action to be done when key is pressed. More than one command
(max 128) can be assigned to a key, but only the first in the list will be signalled.
See below the available commands:

- Talk & Listen = Source and target panels can talk & listen to each other
(both ways communication).

- Talk Only = One way communication. Source talks to Target.
- Listen Only = One way communication. Target listens to Source.

- Remote One Way = A crosspoint between two terminals is created by a
third party panel. This time is one way communication.

- Remote Both Ways =» A crosspoint between two terminals is created by a
third party panel. This time is two waya communication (talk&listen).

- Remote Volume = For crosspoint level changes between two terminals
done by a third party (between —12dB and +12dB). It’ll be necessary to
assign Volume+ to a key and Volume- to another (see below).

- Dial Call = For dialling thru the available telephone interfaces and assigned
telephone numbers.

- Volume + = For increasing a crosspoint audio level in a local way (max
+12dB in +1dB steps) on the incoming audio. It's assigned to one key that
remains the same at the different pages.

- Volume - = For decreasing a crosspoint audio level in a local way (max -
12dB in -1dB steps) on the incoming audio. It's assigned to one key that
remains the same at the different pages.

- Mic/Headphone = It switches between headset and local mic and speaker
(this option will be implemented in future upgrades).

- PROG = For local crosspoint re-programming. user will be able to save the
changes onto the active map. It’s assigned to one key that remains the
same at the different pages.

- PAGE = For page-shifting (it scrolls thru the available virtual pages to
create new crosspoints apart from the ones done by direct keys). This
command must be firstly assigned to a key to create commands in the
virtual pages.

Source = It’s the origin port of the command to be done.

Target = It's the destination port of the command to be done. If the destination
were an interface for PSTN, GSM or ISDN lines, a telephone number can be
chosen.

Label = For easy identification of the command. If left blank, programme will fill it
in automatically. Per the way it's written, user will know about the command. See
below:
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- Talk & Listen -> All the characters in capital letters.
- Talk -> Only the first character in capital letters.
- Listen -> All the characters in small letters.

TP7016 panel has also a symbolic nomenclature for the lower part of the
key. See below:

E 4= Talk & Listen I Remote Both Ways

<frm Remote Valume

E | st Oinly E Bt volume +

Ql Yolame -

Picture 4.47 Key labelling

® Key function = The way the key is used. Three options can be selected per each
key:

- Latch -> Just one light keystroke and the command is activated. For de-
activating, press again.

- PTT (Push To Talk) -> Keep pressing for the crosspoint to be done.

- Normal -> Both ways at the same time. Set by default.

® Private = Privacy with a destination panel. All crosspoints will remain cut when
this private crosspoint is executed. Nobody could listen to what is being talked to
the “private” counterpart. Example: User programmes a Talk command with a
target panel and assign the privacy option. No matter that this user has several
communications established. If he presses the “private” key, only this crosspoint will
be done and only its destination panel could listen to him.

® Audio level 2 for audio volume level variations. Per crosspoint and from -12dB
and +12dB. Set by default: 0dB.

Once all the parameters have been entered, click on ‘Add’. One key can
support up to 128 commands (but only the first of the list is signalled). For exiting, click
on ‘Close’. Repeat this procedure per key to be configured.

If no special parameters need to be entered, it's advised to use the quick
programming way. Select the panel at the left window and go to ‘Edit->Quick
Programming’ (or just click on the following icon):

Guick Programiing
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i* Indico Software - [TEST_TW.XPT]

E File B8 Online Yiew Window Help
[ & Undo Chrl+-Z
[Ouick  Mew Part... ==
oy Mew Group,., : =E

Mew Dial, ..

o] MewIFE.. rt 007 [TP7010]- 7010

Rermove

Propetties..,

Audio Levels. .,
Copy Configuration, ..

Cuuick Prograrnming

R PO07-7010
B, PO05-7210

= nann nonn

Picture 4.48 Quick programming

Before quick-programming, choose the panel and then activate thru the quick-
programming icon. Deactivate this before programming a different panel. The
programming bar will be active for allowing user to quick-programme the panel.

Choose command and destination, and label assigned to the key. Then click on
the key to be programmed.

Source panel cannot be modified as user is programming the chosen panel. For
chosing a different origin, deactivate quick-programming and choose a different panel.

Another option is copying the configuration of one panel into another similar
one. It speeds up the process. Click on the following icon and then the destination

panel.

'i.’f.

4.4.5 LEVEL VARIATION

Kroma Digital Intercom allows level variation per crosspoint between —12dB and
+12dB. Have in mind that max volume is 12dBv, so if an audio signal enters into the
matrix at 7dBu and we increase the level +8dB of that crosspoint, the output audio level
will be 12dBv, not 15dB as you might think.

TA7000/TA7003 interface for convertir external analogue audio signals support
audio level variation as well (input and output). This is very useful for level adapting at
the previous stage, so no need to modify the level of crosspoints.

From “Edit->Audio Levels” menu, any crosspoint level can be changed. Also
user can click on the following icon:

E
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i Indico Software - [TEST_TW.XPT]
E File B8 Online View ‘Window Help
[0 = Undo ChtH-Z

[ Quick  Mew Port... = ==

Mew Group, .. -
Mews Dial... o ¢

=
§  NewIFB.. rt 019 [TP7010] - PO19

Remove

e

Properties, ..

Audio Levels...
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Quick Programming

iEE POO77OL0 |

Picture 4.49 Level variation

Crosspoint Audio Levels

Ciosspoint Level
Souce Taiget &
= o |
o v p @m0~ 3

Cioze 0

Picture 4.50 Level variation per crosspoint

The menu tree of the left side offers the terminals available while the right menu
is for the target terminals. Move the right leveller upwards or downwards for audio
volume adjustment (in 1dB steps).

By default, each crosspoint is established at 0dB. Limits are —12dB and +12dB.
If one signal enters at 1dB and user wants a 6dB output, the increase should be +5dB.

If Origin Signal is a group and Destination is one panel, then level variation will
affect all members of the group. The opposite situation is similar: If Origin is a panel
and Destinatio is a group, level variation will apply to every member of the group.

From the key configuration of panels, audio level from source and target can be
changed as well.

Crozzpoint

Audio Levels
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4.5 ONLINE CONNECTION

Thru RS232 protocol, Indico can interact with Master Unit so user can remotely
control the different maps. Master can save up to 8 maps in its ROM memory, which
can be handled anytime (load, activate, delete...) and its status checked.

Serial COM port of the computer must be configured to connect both
equipments (computer, master) thru twisted cable. Go to ‘File->Options’, where user
will be able to select the serial port of the computer (COM). Frequency is set by default.
There’s no need to configure it unless it is being used by other application.

%]

 Comunication Config | Change Password |

Serial Port;

| COM1 v

Crk4 Farity, 1 Stop

Aceptar ] [ Cancelar Aplical

Picture 4.51 Serial port selection at computer

Once PC and Master are connected and COM port chosen, go to ‘On line-
>Connect to Matrix’ as shown below (or just click on the following icon):

=
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7 Indico Software - TEST_TW.XPT
File Edit BeAiEN Wiew ‘Window Help
[ e [ v“'"i:l:lrlrll:t ko Matrix i
i | Open Map in Masker...
Sawve Map ko Master...

Quick A

@ wl-

Activate Map...
Delete Map. ..
Syskem Status...
Crosspaints. ..

Date|Time Svnchronization

=5 Fo00-7100

EEE POO1-TOMNO
POOZ-RDS

B POO3-GSM DTMF

EEH POO4-TELF = DTMF | Action
Em FOOS-PHOM 0

TR N BTN

Part 002 [TO7000TAFOO1] - RDSI Lire M1

Picture 4.52 Connect to matrix

At the lower right side of the screen, there is status information. If COM port
couldn’t be opened by OS or physical connection problems appeared, a picture as
below will be shown:

Communications error E|

' E Can "t connect ko matrix
L

Picture 4.53 Master connection failure

If there weren’t connection problems, status will be active and Send & Load
icons at the icon tool bar will be shown active as well:

& &

=
User will be able to:

® Open Map in Master 2 |t brings a map into the computer for editing. User
should select among the available maps. .

® Save Map to Master = - To be used when saving a map permanently is
needed. Choose the bank of the master to save the map. If the chosen map is full,
the new map will delete the previous one.
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® Activate Map = User will be able to activate one of the banks of the Master.

® Delete Map = For deleting one of the eight available maps of the Master Unit.
Bank will be blank for future uses. It'll appear as ‘<EMPTY>'.

Select Map E |

Bark 2 1816
Bank 3 16<16-2
Bank 4 <EMPTY>
Bank & <EMPTY>
Bank 6. <EMPTY>
Bank 7 <EMPTY:
Bank 3 <EMPTY>

Cancel |

Picture 4.54 Bank selection

® Date/Time Synchronization = For synchronizing date and time of computer into
the Master. An indicating window informs user.

Indico 5oftware B

Time/D ate succeszzfully changed

Picture 4.55 Time assignment

® System Status = For system checking in real time and thru equipment
connections, serial numbers and firmware versions. It tells on matrix type, that
should be the same that the declared at Indico’s configuration map. The models or
matrix to configure are:

TM7016 -> Matrix 0 with one A board. It's a 32-port equipment with one
16x16 XPT board.

TM7024 -> Matrix 0 with one A board. It's a 32-port equipment with one
24x24 XPT board..

TM7032 -> Matrix 0 with one A board. It's a 32-port equipment with one
32x32 XPT board.
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TM7064 -> Matrix 0 and matrix 1 with two boards (A, B) in each of the two
matrixes. It's a 64-port equipment (two 32-port equipments together). Each
matrix consists of one main XPT board (A) and the extension one (B).

TM7096 -> Matrix 0, matrix 1 and matrix 2 with three boards (A, B, C) in
each of the three matrixes. It’s a 96-port equipment (three 32-port equipments
together). Each matrix consists of one main XPT board (A) and the extension
ones (B, C).

TM7128 -> Matrix 0, matrix 1, matrix 2 and matrix 3 with four boards (A, B,
C, D) in each of the four matrixes. It's a 128-port equipment (four 32-port
equipments together). Each matrix consists of one main XPT board (A) and the
extension ones (B, C, D).

If one of the boards is missing or faulty, a green strip will indicate that as a
‘Warning'. This board will not appear in square brackets as operative ones: [A]

If Matrix isnt connected or it doesn’t reply to Master orders, a red strip will
appear informing about an ‘Error'. Check connections, power supply...

See below a 128-port matrix, equipped with four 32-port units. Note that each
one has four XPT boards: [A], [B], [C] y [D]. Status is ‘OK’

Syztem Stalus

Malis | Stebus | Type [ Boads | S/M [ Useive | Altes .. | Observations |
(Al kK, [TH7128  [EATRICID]|01-1M09-01 . 2.00.155 |+.1.0

1 K TM7IZE | ATBICID] 000000 2 0015 1D | e
0z K, [TM7128 |IATEICHD|00000000( 200155 [v1.0 | _":’_".I
033 [1[4 TMTI2E  [ATEHCHC00-0000-001w.2.00.158 [v+1.0

Perl | Mame | Glaws | Type | SM | User ve, | Allea v, | Observations | =

Picture 4.56 Status Checking

See above how port status is also checked. It indicates model, S/N and
software version. If functioning is right, it’ll appear ‘OK’ next to its description.

If the terminal assigned via Indico programme and physical terminal connected
to the matrix doesn’t match, a ‘Warning’ and a green strip will appear.
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If terminal doesn’t reply properly because a lack of connection (or a faulty
terminal), an ‘Error message and a red strip will appear. At the picture above, only
ports 0, 6 and 7 are working. The rest offers sme kind of error. This menu is very useful
for the setting up of the intercom system for port checking of every connected
equipment.

® Crosspoints = This option of the Online Menu allows the user to view and modify
each crosspoint of the system in real time thru a graphic interactive screen. Each
XPT can be created, edited or deleted. For de-activating this option, connection to
master must be active.

% | Indico Software - TEST_TW.XPT
File Edit EeRNEN Wiew Window Help

[y & | w Connect to Matrix
| | Open Map in Master, ..

Cuick F e 7100 .l

b | Save Map to Master...
5 5 [

Activate Map...
Delete Map...
Swskem Status. ..

Drate) Time Synchronization

=8 FO00-7100
EEE POO1-TOMOD

Part 002 [TODF000/TAFOOT] - RDSI

B PANG-G5M DTMF
Picture 4.57 XPT menu activation

All crosspoints of the system will appear: inputs at the upper side and outputs at
the left part of the map. When moving the mouse, the input and output will be yellow-
shadowed to let the user know which crosspoint can be created if left-clicking.

e A e i

=l EE

B i ol 2R i.%! z

=
B
=

Picture 4.58 XPT activation window
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This window is very useful for viewing in real time which crosspoints are being
created. Each XPT can be:

- Not done > A white square will indicate that the audio input is not going to
that output. There is no crosspoint there.

- Done - A blue square will indicate that the audio input is going to that
output. Picture above tells that audi ofrom port labeled ‘BP1’ is addressed to
port ‘P022’.

- Forced XPT > A red square tell about a done XPT (by the user thru Indico,
or a Master panel) or about an IFB.

For creating XPTs manually, click on the desired square (the intersection
between the ports that we want to join). The square’ll fill in red (done & forced). For
releasing the XPT, just click on it again.

User will be able to “force” a done crosspoint. Just click on a blue square. It’ll
turn to red. For returning to blue, click on it again.

Note that this way is aimed at creating one way communication. Full duplex
needs another steo. Once the XPT is done, just click on the right button of the mouse.
A two-way channel will have been created. For returning to one-way, click on the right
button again.
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5 DOCUMENTATION

With the Mantenance Manual, parts lists are enclosed (including electric
schematics). Nomenclature for these parts are related to the equipment they belong to.
The capital letter next to the code means as follows:

- ‘R’ > Product with all parts together, finished, completed.

- ‘X’ > Optional product.

- ‘T’ = Expansion product.

- ‘P’ > Part list for a Printed Circuit Board (PCB).

- ‘W’ > Parts schematics, diagram.

- ‘B’ & Electric schematics (parts interconnection).

- ‘I > PCB where parts will be soldered upon.

- ‘K’ = Mechanical kit (chassis of the equipment).

- Y’ & Individual mechanical part.

- ‘L’ = Software kit (firmware).

- ‘U = Interconnection kit (cabling).

- ‘M’ = Interconnection cabling.

-V’ > Diagram/Drawing of one part of the equipment.

- J, 'C > Different parts that put together conform a module inside the

equipment.

More info can be found at the CDRom:
\\CD-ROM\ TB7000\ ..
\Schematics
\Manual
\Firmware
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